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What's New

Sanction® 4 provides the following new features and enhancements:

Drag and drop import 

You can import items via drag and drop. For more information, see: Importing Exhibits,  Importing
Media, and Importing Transcripts.

Rotate pages and documents 

You can rotate individual pages and entire documents. For more information, see: Rotate Pages and
Documents.

Delete all annotations or exhibit stamps

You can delete multiple annotations and exhibit stamps at the same time. For more information,
see: Annotation Tools and Exhibit Stamps.

Create copies of exhibit pages 

You can save as many copies of an exhibit page as you want. Then you can apply a different set
of annotations to each copy. For more information, see: Save as New Page.

Copy video files to the case folder 

You can run a command that copies to the case folder all of the video files referenced in your
case. For more information, see: Copy Video Files to the Case Media Folder.

Find source items for items in a presentation 

After you add an item to a presentation, you can easily locate the item in your case folders. For
more information, see: Find the Source Location of Items.

Font options for transcripts

You can customize the font that is used to display transcripts. For more information, see: Set
Transcript Viewer Options. 

Default edge of Tear Out tool 

You can change the default border of tear outs to a jagged edge. For more information, see: 
Annotation Tools.

Column layout

You can adjust the column width, move columns, and sort by column for exhibits, and media. For
more information, see: Customizing the Layout.

New keyboard shortcuts

Numerous new keyboard shortcuts (hotkeys) have been added. See: Keyboard Shortcuts.

How to video library

Access online videos that show how to do many common tasks.
..

Related Topics

Importing Exhibits,  Importing Media, and Importing Transcripts.

Add or Replace Exhibit Pages

Annotation Tools and Exhibit Stamps

Save as New Page

http://www.lexisnexis.com/en-us/litigation/products/tutorials.page
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Copy Video Files to the Case Media Folder

Find the Source Location of Items

Set Presentation Options

Customizing the Layout

Keyboard Shortcuts
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Quickstart, Layout, and Navigation

Quick Start Guide

For those new to Sanction®, this topic provides a basic workflow you can use to put together and
run your first presentation. Links to the main topics that represent each step in the workflow are
provided. To try the main steps on your own, consider opening the sample case that comes with
Sanction. Or create your own test case and populate it with documents, images, media, and
transcripts of your choosing. 

Tasks listed under More things to try, represent suggested next steps to try after you have
completed the major steps. 

To start Sanction, click the Start menu, click All Programs, click LexisNexis CaseMap Suite,
and then click LexisNexis Sanction. 

You can also download a PDF of Sanction Keyboard Shortcuts.

Step Topics

Step 1. Create your case. Create, Open, and Pin Cases

Other things to try out in this step:

Open the sample case to practice. Sample Sanction Case

Change the default location where cases

will be saved. 
Change the Default Case Path

Create folders in your case to help keep

exhibits and media organized.
User Folders 

Step 2. Import exhibits, media, and
transcripts

Importing Exhibits

Importing Media

Importing Transcripts

Other things to try out in this step:

Configure Sanction to find media for your

case in any folder path on your computer.

Preferred Media Paths

Step 3. Prepare exhibits for presentation. Annotation Tools

Other things to try out in this step:

Show layers of annotations to help

reinforce your point.
Annotation Layers

Create a screen capture, which is a new

exhibit you make from an existing
exhibit. 

Screen Captures

Create a video still, which is a new exhibit

you make from a single frame of video.

Video Stills

Rename or renumber your exhibits

individually or in batches. 

Editing Item Properties

Wizards for Renaming, Renumbering, and Bates

http://help.lexisnexis.com/litigation/ac/sanction_docs/Sanction4_KBSC_QRC.pdf
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Numbering

Stamp exhibits with page names, exhibit

or trial numbers, or Bates numbers.
Exhibit Stamps

Step 4. Prepare media for presentation.
Media Clips

Playlists

Step 5. Prepare transcripts for
presentation.

Create a text clip, which is a new exhibit

you make from the text of an exhibit.

Create media clips from a synchronized

transcript.

Text Clips 

Synchronized Transcripts

Other things to try out in this step:

Search for transcript text.

Searching Transcript Text

Step 6. Create your presentation.

Creating a Presentation

Adding and Removing Items

Other things to try out in this step:

After adding items to your presentation,

you can change the sequence in which
they will be presented. 

Prior to running a presentation, review

the options you can set for running
presentations. 

Changing Item Presentation Sequence

Setting Presentation Options

Step 7. Run your presentation.
Opening and Closing the Presentation Window 

Controlling Item Presentation

Other things to try out in this step:

Start, pause, and stop playback, of

media, clips, and playlists. 

Media Playback

Add items to your presentation in real

time.

Using the Show Item Command

Display 2, 3, or 4 items at the same time

in the presentation window.

Displaying Multiple Item Windows

Annotate an exhibit in real time. Annotating in Real Time

Related Topics

Activation

Customizing the Layout

Keyboard Shortcuts

Customizing the Layout
You can adjust the layout of the main program window to accommodate how you want to work. 

When working with exhibits, exhibit pages, and media, you can change the column width, move

columns, and sort item lists by column value.
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When working with exhibits and exhibit pages, you can choose to show or hide columns that show

the number of pages, exhibit number, trial exhibit number, admit date, begin Bates number, and
end Bates number.

When working with annotation tools, you can give yourself more screen space by hiding the exhibit

details. If you decide to show exhibit details, you can position them either to the left or to the right
of the exhibit page viewer.

When working with exhibits and other items, you can further customize the workspace by

collapsing and expanding navigation panels. Collapsing the panels hides the folder list and the
navigation bars. 

Note that the layout customizations you make persist between sessions.

To change column width

1. Position your mouse over margin of the column you want to resize.

The cursor changes.

2. Drag left or right to resize the column.

 To show or hide exhibit and page list columns

1. Right-click any column header for either the exhibit list or the page list.

2. Select the columns you want to be displayed. 

Right-click exhibit list or exhitbit page list 

 To move columns

Drag the column header left or right to its new position. 

 To sort a list by column value

1. Click the column you want to sort by. 
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A small sorting icon appears at the top of the selected column.

Exhibit list sorted by Exhibit #

2. Click the column header.

The list is sorted on the values in that column.

To control the item details panel

1. Click the Exhibits navigation bar.

2. Select one of the following options, depending on what you want to do:

Option Steps

Position exhibit details to the left of the exhibit
viewing window.

In the VIEW tab, in the Layout group, click 
Details View and then click Left.

Minimize the details to the left of the exhibit
viewing window.

In the VIEW tab, in the Layout group, click 
Details View and then click Minimized.
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Position exhibit details to the right of the exhibit
viewing window.

In the VIEW tab, in the Layout group, click 
Details View and then click Right.

To minimize the navigation pane

Do one of the following:

Click the navigation bar minimize button.

On the VIEW tab, in the Layout group, click Navigation Pane and then click Minimized.

To restore the navigation pane to its original size

Do one of the following:

Click the navigation bar maximize button.
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On the VIEW tab, in the Layout group, click Navigation Pane and then click Normal.

Related Topics

Keyboard Shortcuts

Navigating Sanction

Presenting on a Second Display

The FILE Tab

This topic describes the functional areas of Sanction having to do with the FILE tab. You can access
many wizards from the FILE tab. You can also set the default behavior for tools and for the
presentation window, as well as set many of the properties for the case, such as paths to media. 
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The FILE tab

Interface
element

Description

1. Program tabs These provide access to other areas of the program: HOME, VIEW, and
IMAGE TOOLS, which are described in the topics that follow.

2. Back button This button collapses the FILE tab. It is only active when a case is open.

3. Info area Import -- Add Items. Use this to import exhibits, media, transcripts, or

exhibit load files. Overview of Importing

Rename & Renumber -- Renaming and Numbering Wizards. Use this

to rename exhibits, and to generate exhibit numbers and Bates numbers. 
Wizards for Renaming, Renumbering, and Bates Numbering

Exhibit Stamp -- Exhibit Stamp Wizard. Use this to apply exhibit

stamps, which may include: page name, exhibit number, trial exhibit
number, Bates number and case number.  Exhibit Stamps.

Export -- Export Files. Use this to export exhibits, media clips, and

playlists. Exporting Exhibits, Media Clips, and Playlists

Copy Video Files -- Copy video files to the case media directory.

When you import video files, Sanction simply creates a link to the source
location of the video. If you ever want to move your case, running the
Copy Video Files wizard can help you to consolidate all the video for your
case into the case folder. Copy Video Files to the Case Media Folder

Case Properties -- Case Directory. Shows and allows you to change the

default directory for your case file and case folder. Change the Default Case
Path

File Version. Shows the major and minor version number of your copy of

Sanction. 

Media Paths -- Case Media Paths. Use this to add, remove, or change

folder paths to media for the case. Preferred Media Paths
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4. Open case and
Close case

Open

Select a recently opened case, browse to an existing case, or open a new

case. Also pin a case to the case list so you can quickly access it later on. 
Create, Open, and Pin Cases

Access the sample case. Sample Sanction Case

Close

Close the currently open case.

5. Help, Options,
About, and
Activate

Help

Open product documentation. 

Access How to Video Library

Options

Set the default case folder. Change the Default Case Path

Set options for the media player. 

View the storage location for log files. annotations and for the presentation

windows. Setting Presentation Options

Set the default annotation tool.

Change font settings for the annotation text tool.

Set options for the tear out tool.

Set the resolution for PDF files.

Set options for the presentation of synchronized text.

Set numerous options for the presentation window.

About

View version information, product registration information, and the end-

user license agreement (EULA).

Activate

Start the product activation wizard. Activation

Related Topics

Customizing the Layout

Keyboard Shortcuts

http://www.lexisnexis.com/en-us/litigation/products/tutorials.page
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HOME - Exhibits Area

You can access exhibits and related program functionality in the Exhibits area.

Interface element Description

1. Button groups for Exhibits These button groups provide functionality for working with
exhibits. 

2. Case properties panel Right-click the panel to access the case media paths and case
properties. For more information, see: Set Presentation Options,
Change the Default Case Path, and  Preferred Media Paths.

3. Default exhibit folders These folders are created for you when you create a case. They
cannot be moved, renamed, or deleted. 

The Captures folder is where Sanction puts the screen captures

that you make of exhibits. For more information, see: Screen
Captures and Default Folders and Item Types.

The Text Clips folder is where Sanction puts images that you clip

from sections of transcripts. For more information, see: Text
Clips.

The Timelines folder is a place where you can store images of

timelines. 

The Video Stills folder is where Sanction puts still images that

you create from video frames. For more information, see:
Video Stills.

4. A user folder In the screen capture above, MyFolder is an example of a user-
created folder.
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User folders can be renamed, moved, or deleted as needed.

For more information, see: User Folders.

5. Navigation bars These provide access to folders for exhibits, media, transcripts, and
presentations. 

6. Navigation Pane minimize
button

This button minimizes the navigation pane. Use this as an
alternative to the VIEW menu, Navigation Pane selection. 

See: Customizing the Layout

7. Exhibit list

          and 

8. Exhibit page list

The exhibits contained in the selected folder. 

The pages of the selected exhibit.

9. Exhibit viewer Provides a view of the selected exhibit page. 

10. Layout controls Provide control over layout/magnification in the exhibit viewer.

The Exhibits navigation bar

When you click the Exhibits navigation bar, the button groups of the HOME menu change to reflect
options available when working with exhibits.

Home tab when Exhibits navigation bar is selected

Shortcut keys - HOME > Exhibits Area
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Group > Button Task Shortcut

New > Import
Import exhibits, media, transcripts,
exhibit load files, and clip lists.

Ctrl+I

New > New
Folder

Create a new folder. Ctrl+Shift+F3

New > Capture
Create a screen capture of the
contents of the exhibit viewer.

F7

Actions >
Rename

Rename items and folders. F2

Actions > Update
Exhibit

Add pages to an exhibit or update
existing pages. 

Ctrl+U

Actions > Edit
Edit exhibit or page properties, such
as the name, exhibit number, or
Bates number.

Ctrl+Shift+I

Actions > Move Move the selected exhibit. Ctrl+Shift+F2

Actions > Delete Delete the selected exhibit. Ctrl+D

Actions >
Rename Folder

Rename the selected folder. Ctrl+Shift+F

Actions > Move
Folder

Move the selected folder. Ctrl+Shift+M

Actions > Delete
Folder

Delete the selected folder. (Folder
must be empty.)

Ctrl+Shift+D

Add To >
Presentation

Add the selected page to the existing
presentation of your choice. Or
create a new presentation from a
selected page.

Ctrl+Shift A

Present >
Presentation

Open the presentation window. Ctrl+Shift+F1

Present > Show
Item

Immediately open the selected item
in the presentation window.

Ctrl+S

Share > Export
Export exhibits, clips, playlists, and
duration list reports. 

Ctrl+Shift+E

Share > Print Print exhibits. Ctrl+Shift+P

Search > Find
Items

Search for items by item properties,
such as name, exhibit number, trial
number, Bates number, or
description.

Search for items by admit date or
transcript date. 

Ctrl+F

Related Topics

Customizing the Layout

Keyboard Shortcuts
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HOME - Media Area

You can access media, playlists, clips, and related program functionality in the Media area.

Interface element Description

1. Case properties panel Right-click the panel to access the case media paths and case
properties. For more information, see: Set Presentation Options,
Change the Default Case Path, and  Preferred Media Paths.

2. Media folders The Media folder and its Videos subfolder are created by default and
cannot be moved or renamed. However, you can create new folders
in the Media folder.

3. Playlist folder This folder holds playlists.

4. Navigation bars These provide access to exhibits, media, transcripts, and
presentations.

5. Navigation Pane
minimize button

This button minimizes the navigation pane. Use this as an alternative
to options on the VIEW tab. For more information, see: Customizing
the Layout.

6. Media item list Select an item to view it in the media player.

7. Clip Creator Use this to create and edit media clips.
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8. Media player With the Media player, you can play media, clips, and playlists, and
create video stills.

9. Clip list Provides a list of any clips created from the selected media item.
When clips are selected, the Playlist button becomes active. If no clips
have been created for the selected media item, the list is empty.

The Media navigation bar

When you click the Media navigation bar, the button groups of the HOME menu change to reflect
options available when working with media, clips, and playlists.

HOME tab when Media navigation bar is selected

Shortcut keys - HOME > Media

Group > Button Task Shortcut

New > Import
Import exhibits, media, transcripts,
exhibit load files, and clip lists.

Ctrl+I

New > New
Folder

Create a new folder. Ctrl+Shift+F3

New > Video Still
Create a video still from a frame of
video.

Ctrl+Shift+V

Actions >
Rename

Rename the selected media or clip. F2
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Actions > Edit
Edit the properties of the selected
media or clip.

Ctrl+Shift+I

Actions > Move Move the selected media item. Ctrl+Shift+F2

Actions > Delete Delete the selected media or clip. Ctrl+D

Actions >
Rename Folder

Rename the selected folder. Ctrl+Shift+F

Actions > Move
Folder

Move the selected folder. Ctrl+Shift+M

Actions > Delete
Folder

Delete the selected folder. (Folder
must be empty.)

Ctrl+Shift+D

Actions > Move
Up

Move the selected clip up in the
playlist.

Ctrl+Alt+U

Actions > Move
Down

Move the selected clip down in the
playlist.

Ctrl+Alt+U

Actions >
Remove Item

Remove the selected clip from the
playlist.

Ctrl+Alt+R

Add To >
Presentation

Add the selected media to the
existing presentation of your choice.
Or create a new presentation from a
selected media.

Ctrl+Shift A

Add To > Playlist
Add the selected clip to an existing
playlist. Or create a new playlist
from a selected clip.

Ctrl+Y

Present >
Presentation

Open the presentation window. Ctrl+Shift+F1

Present > Show
Item

Immediately open the selected item
in the presentation window.

Ctrl+S

Share > Export
Export exhibits, clips, playlists, and
duration list reports. 

Ctrl+Shift+E

Share > Print Print exhibits. Ctrl+Shift+P

Search > Find
Items

Search for items by item properties,
such as name, exhibit number, trial
number, Bates number, or
description.

Search for items by admit date or
transcript date. 

Ctrl+F

Related Topics

Customizing the Layout

Keyboard Shortcuts

HOME - Transcripts Area

You can access transcripts, synchronized transcripts, and related program functionality in the
Transcripts area.
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Interface element Description

1. Case properties panel Right-click the panel to access the case media paths and
case properties. For more information, see: Set
Presentation Options, Change the Default Case Path, and
 Preferred Media Paths.

2. Transcript list Lists all the transcripts that have been imported into the
case.

3. Navigation bars These provide access to exhibits, media, transcripts, and
presentations.

4. Navigation Pane minimize button This button minimizes the navigation pane. Use this as an
alternative to options on the VIEW tab. For more
information, see: Customizing the Layout.

5. Transcript highlighting* When a synchronized transcript is playing, the current line
is highlighted with the color of your choice.  Highlight color
can be changed by opening the Sanction Options dialog
box. For more information, see: Set Presentation
Options.

6. Paging controls Using these controls, you can: page through the
transcript one page at a time, go to the first or last page,
or go to a page by typing.

7. Search bar Use this to search for text within the selected transcript.
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Buttons allow you to move forward and back between
search hits.

8. Transcript window With the transcript window, you can select text and then
right-click to create a text clip. 

In addition, if the transcript has synchronized media,
when you right-click a selection, you can create a media
clip.

9. Clip list* The list of clips created from the selected synchronized
transcript.

10. Media player* Plays the video of the transcript. The transcript text
remains in sync as you use the media player to go to
different parts of the transcript.

11. Clip Creator* Use this to create and edit media clips from the selected
synchronized transcript.

* Feature becomes available when a synchronized transcript is selected.

The Transcripts navigation bar

When you click the Transcripts navigation bar, the button groups of the HOME menu change to reflect
options available when working with transcripts and synchronized transcripts.
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Home tab when Transcripts navigation bar is selected

Shortcut keys - HOME > Transcripts

Group > Button Task Shortcut

New > Import
Import exhibits, media, transcripts, exhibit load
files, and clip lists.

Ctrl+I

New > Media Clip
Create a new media clip from selected lines in  a
synchronized transcript.

Ctrl+Alt+M

New > Text Clip Create an image of the selected transcript text. Ctrl+Shift+X

New > Video Still
Create a new video still from a frame in a
synchronized transcript.

Ctrl+Shift+X

Actions >
Rename

Rename the selected transcript. F2

Actions > Edit Edit transcript properties. Ctrl+Shift+I

Actions > Delete Delete the selected transcript. Ctrl+D

Add To >
Presentation

Add the selected transcript to the existing
presentation of your choice. Or create a new
presentation from a selected transcript.

Ctrl+Shift A

Add To > Playlist
Add selected clip (from a synchronized transcript)
to an existing transcript, or create a new
transcript from the selected clip. 

Ctrl+Y

Present >
Presentation

Open the presentation window. Ctrl+Shift+F1

Present > Show
Item

Immediately open the selected transcript in the
presentation window.

Ctrl+S

Share > Export
Export exhibits, clips, playlists, and duration list
reports. 

Ctrl+Shift+E

Search > Find
Items

Search for items by item properties, such as
name, exhibit number, trial number, Bates
number, or description.

Search for items by admit date or transcript date. 

Ctrl+F

Related Topics

Customizing the Layout

Keyboard Shortcuts
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HOME - Presentations Area

You can access presentations and their contents in the Presentations area.

interface element Description

1. Case properties panel Right-click the panel to access the case media paths and case
properties. For more information, see: Set Presentation Options,
Change the Default Case Path, and  Preferred Media Paths. 

2. Presentation list The presentation list shows all of the presentations in your case.
The Default Presentation is a blank presentation that is built into
every case. In the screen capture above, Hawkins Examination is
an example of a presentation created by a user.

3. Navigation bars These provide access to exhibits, media, transcripts, and
presentations.

4. Navigation Pane minimize
button

This button minimizes the navigation pane. Use this as an
alternative to options on the VIEW tab.

5. Presentation item list This is the list of items in the selected presentation.

6. Item viewer window Shows a preview of the currently selected item. Switches modes
between exhibit viewer, media viewer, transcript viewer, or
synchronized transcript viewer, depending on the item type
selected.

7. Layout tools Provides options to fit and zoom the selected image in the
viewer.

For more information on these controls, see: Creating a Presentation , Adding and Removing
Items , and Opening and Closing Presentations.
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The Presentations navigation bar

When you click the Presentations navigation bar, the button groups of the HOME menu change to
reflect options available when working in the presentations area of the main program window.

Home tab when Presentations navigation bar is selected

Shortcut keys - HOME > Presentations

Group > Button Task Shortcut

New > Import
Import exhibits, media,
transcripts, exhibit load files,
and clip lists.

Ctrl+I

New > New
Presentation

Create a new presentation. Ctrl+Shift+N

Actions >
Rename

Rename selected
presentation. 

F2

Actions > Delete Delete selected presentation. Ctrl+D
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Actions > Move
Up

Move selected items up in the
presentation.

Ctrl+Alt+U

Actions > Move
Down

Move selected items down in
the presentation. 

Ctrl+Alt+D

Actions >
Remove Item

Remove selected items from
the presentation. 

Ctrl+Alt+R

Add To >
Presentation

Add the currently selected item
to a different presentation, or
create a new presentation
from a selected item.

Ctrl+Shift+A

Present >
Presentation

Open the selected
presentation.

Ctrl+Shift+F1

Present > Show
Item

Open the selected item in the
presentation window.

Ctrl+S

Share > Export
Export exhibits, clips, playlists,
and duration list reports.

Ctrl+Shift+E

Display Mode

Only active when presentation
window is open.

When View Mode is set to Side
By Side, 3 Across, or 4
Quadrants:

Allows you to move through

your presentation using any
item window.

Prevents new item windows

from opening.

Display Mode
(locked)              

Display Mode
(unlocked)

Ctrl+Shift+T 

(Toggles on/off)

View Mode

Allows you to select between
Full Screen, Side By Side, 3
Across, or 4 Quadrants.

Only active when presentation
window is open.

Regardless of which View Mode
is selected, when you open a
presentation, the window
opens as a Full Screen.

Full Screen: Ctrl+Shift+Up Arrow

Side By Side: Ctrl+Shift+Left Arrow

3 Across: Ctrl+Shift+Right Arrow

4 Quadrants: Ctrl+Shift+Down Arrow
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Related Topics

Customizing the Layout

Keyboard Shortcuts

The VIEW Tab

You can control the layout the main program window and send your presentations to a second
monitor by using the options on the VIEW tab.

The VIEW tab

Group > Button Task Shortcut

Layout > Details View
Change the details view of exhibits to left,
minimized, or right.

Ctrl+Alt+V 

Layout > Details View
Show or minimize navigation panes. Ctrl+Alt+N

Monitors

Show presentations on a second display, such as
an external monitor or projector. 

For more information, see: Presenting on a Second
Display

Ctrl+Alt+Y 

Related Topics

Customizing the Layout

Keyboard Shortcuts

The IMAGE TOOLS Tab

You can add sophisticated, multilayered annotations to exhibit pages by using the tools on the IMAGE
TOOLS tab.  

To access the IMAGE TOOLS tab, you need to first select an exhibit page, either in the Exhibits area
or the Presentations area. When the IMAGE TOOLS tab is selected, the following button groups are
available.
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The IMAGE TOOLS tab

Group > Button Task Shortcut

Tools > Select Selection tool. Ctrl+Shift+S

Tools > Crop Crop and zoom. Ctrl+M

Tools > Tear Out
Magnify a selected part of the page and move
the selection around.

Ctrl+O

Tools > Magnifier Drag a magnifier across the exhibit. Ctrl+Alt+G

Tools > Pan
Drag a zoomed page around in the exhibit
viewer window.

Ctrl+Alt+P

Tools > Erase

Erase annotations one at a time.

Note -- in the presentation window, the
shortcut key for Erase is Ctrl+D .

Ctrl+Alt+S

Tools > Delete Annotations

Delete all of the annotations or exhibit stamps
applied to selected exhibit pages.

IMPORTANT

In presentation window, Ctrl+Delete
immediately deletes all visible annotations.

Ctrl+Delete

(IMAGE TOOLS tab
only)

Annotations > Highlight Create a transparent rectangle. Ctrl+H

Annotations > Arrow Draw an arrow. Ctrl+W

Annotations > Line Draw a line. Ctrl+L

Annotations > Pen Draw a freehand line. Ctrl+N

Annotations > Rectangle Create an unfilled ellipse. Ctrl+G

Annotations > Ellipse Create an unfilled rectangle. Ctrl+E

Annotations > Redaction Create a filled rectangle. Ctrl+R

Annotations > Text Type text into the exhibit. Ctrl+Alt+X

Options > Line Size
Set the line thickness for: arrow, line, pen,
rectangle, and ellipse.

Ctrl+Alt+I

Options > Line Color
Set the line color for: arrow, line, pen,
rectangle, and ellipse.

CTRL+Alt+O

Options > Fill Color
Set the fill color for: highlight, redaction, and
text box.

Ctrl+Alt+F

Layers > 1 - 9

Select a layer and show it if it is hidden.

For more information, see: Annotation
Layers.

Ctrl+[Layer#] 

(e.g. 2 - 9)

Image > Rotate Right Rotate page right. Ctrl+Period

Image > Rotate Left Rotate page left. Ctrl+Comma

Image > Print Print the selected exhibit page. Ctrl+Shift+P

Related Topics

Customizing the Layout
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Keyboard Shortcuts

The Presentation Window

The presentation window is what your audience will see when you run your presentation. By default,
the presentation windows opens a single item at a time, however, the presentation window can be
divided into multiple item windows. You can control the presentation window using tools available in
the presentation task bar and in each item window. You can also control the presentation from the
main program window, if the presentation is running on a second display. 

This topic describes the functional areas and controls of the presentation window.

Presentation window controls

The Presentation Window

interface element Description

1. Item windows The presentation window can show up to four item windows
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simultaneously. The screen shot above shows the presentation
window hosting 3 item windows: a time line image on the left, a
synchronized transcript in the center, and a document exhibit on the
right. For more information, see: Displaying Multiple Item Windows.

2. Item window controls Each item window is equipped with its own set of controls:

1. Item selector. Use this to open an item by typing its name or by
selecting it from a list.

2. Annotation tools. Use this to access annotation tools.

3. Page fit and layers. Use this to adjust the page layout and work
with the annotation layers of an exhibit. 

For more information see: Setting Presentation Options, and
Annotation Layers.

3. Presentation taskbar The taskbar provides tools for you to control the presentation. The
task bar can be hidden or otherwise configured. For more
information, see: Setting Presentation Options.

The taskbar has the following components: the presentation
selector, task

4. Presentation selector Lists all the presentations in the case. 

Select this to:

Switch from presentation to presentation.

Close the presentation window. 

For more information see: Opening and Closing Presentations.

5. Presentation window
buttons

Each open item window gets its own button in the taskbar.  

A blue border around the item name indicates the item is the one
that is active in the presentation window. 

6. Presentation window
controls

The presentation window is equipped with a set of controls:
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1. Next item/Previous item. Use these to move back and forward
between items in the presentation.

2. Item selector. Use it to: 

o Select items to display from a list of the items in the

presentation. 

o Access a search box for opening an item by typing a name,

exhibit number, trial exhibit number or Bates number. 

o Create screen captures. 

3. View Mode. Use this to configure the presentation window to
display as: Full Screen, Side-by-Side, 3 Across, and 4 Quadrants. 

4. Display Mode. Works in conjunction with the View Mode. When
unlocked, you can suspend new item windows from opening,
regardless of the View Mode setting. It also allows you to select
which item window you want to use to move through the
presentation.

 Display Mode locked         Display Mode unlocked

For more information, see: Displaying Multiple Item Windows.

5. Presentation options This button opens the Sanction Options dialog box, which contains
settings that govern: item display, item borders, tear out borders,
media playback, task bar options, and text appearance for
transcripts.

For more information on these controls, see: Controlling Item Presentation.

Presentation window shortcut keys

Action Key combination

Full Screen view mode F11 

or

Alt+Shift+Up Arrow

Side by Side view mode Alt+Shift+Left Arrow 

3 Across view mode Alt+Shift+Right Arrow

4 Quadrant View  Alt+Shift+Down Arrow 

Rotate image counterclockwise Ctrl+Comma
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Rotate image clockwise Ctrl+Period

Select Ctrl+Shift+S 

Crop/Zoom Ctrl+M 

Tear out (in presentation window) Ctrl+O 

Pan In the presentation window, there is
no shortcut key for the Pan tool.

In the main program window, Ctrl
+Alt+P activates the Pan tool.

Erase Ctrl+D in the presentation window.

In the main program window, Ctrl
+Alt+S activates Erase tool.

Delete all visible annotations Ctrl+Delete 

In presentation window, this
shortcut deletes all visible
annotations.

In main program window, this
shortcut activates the Delete
Annotations menu item.

Highlight Ctrl+H

Arrow Ctrl+W 

Line Ctrl+L

Pen Ctrl+N 

Rectangle Ctrl+G

Ellipse Ctrl+E 

Redaction Ctrl+Shift+R 

Play\Pause media Ctrl+P 

Show previous item Ctrl+Left Arrow

Show next item Ctrl+Right Arrow

Close all other item windows Ctrl+Shift+F4 

Display Mode lock/unlock Ctrl+Shift+T 

Zoom in/out exhibit page (using mouse) Ctrl+Mouse wheel forward 

or 

Ctrl+Mouse wheel back 



LexisNexis Sanction36

© 2015 LexisNexis. All rights reserved.

Zoom in exhibit page (using keyboard) Ctrl+Plus

or 

Ctrl+Equal

Zoom out exhibit page (using keyboard) Ctrl+Minus

Next presentation 

Previous presentation

Ctrl+Alt+P 

Shift+Alt+P

Clear presentation window Esc

Close presentation window Shift+Esc 

Close all item windows Shift+F4 

Select next item window Tab

Select previous item window Shift+Tab 

Layer visibility Ctrl+[Layer#] (e.g. 2 - 9) to
toggle on/off

Show next hidden layer F12 

(not available in main program
window)

Hide last visible layer Shift+F12

(not available in main program
window)

Capture F7 

Page up and page down through a multi-page exhibit Page Up

Page Down 

Page forward like a book Ctrl+J

Related Topics

Customizing the Layout

Keyboard Shortcuts
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Installation, Activation, and Repair

Activation

You can run an unregistered version of Sanction for up to 30 days without purchasing a license for it.
After that time, you must activate your installation by purchasing a license for it and then registering
the license.

A prompt to activate Sanction prior to the end of the grace period

When you first open Sanction you are prompted to activate your installation. If you choose not to
activate at that time, you can do so the next time you open Sanction. Alternatively, whenever
Sanction is running you can activate while in the program. 

Prior to activating Sanction you will need to have the following information ready:

A registration name, a registration ID, and a Product ID. This information is provided by LexisNexis

when you purchase the license.

An activation key. After you purchase the license, LexisNexis sends an activation key to you in an

email message. For more information on activating Sanction call 877.301.0344 to speak to a
technical support agent. Hours of operation are Monday through Friday, 9:00 AM to 9:00 PM
Eastern Time.

If you uninstall Sanction from a computer and then reinstall Sanction on the same computer, you
will need to activate Sanction again. 

To activate Sanction

1. Do any of the following:

Start Sanction. At the prompt to activate Sanction, click Yes. 

If Sanction is running without a case open, click Activate. 

If Sanction is running and a case is open, on the FILE tab, click Activate.

2. Read the LexisNexis License Agreement. If you agree to the terms, click the check box and then
click Next. 

3. Select a method for completing the activation process. You can select:

Internet activation. This option runs an automated script and requires an Internet

connection. 

Phone. To activate by phone, call 800.833.3346 (option 3) to speak to a technical support

agent. Phone support is available Monday through Friday, 9:00 AM to 9:00 PM Eastern Time.

Web browser. This method requires an Internet connection.

4. Follow the prompts to complete activation. 

To determine if Sanction is already activated
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Start Sanction. 

If the activation prompt does not open, then Sanction is activated. 

If Sanction is already running, in the Sanction main window, click the FILE tab and then click

Activate.  A message box confirms activation. If Sanction is not yet activated, the activation
wizard will start.

Related Topics

Installing Sanction

System requirements

Repairing Sanction

Installation

Note the following when preparing to install Sanction. 

Install Sanction to your local computer. Installation to a server, mapped drive, or network share

is not recommended.

Backward compatibility. 

You can install Sanction® 4 alongside Sanction II.9. 

Sanction 4 may not be installed alongside Sanction 3.x. 

Prior to installing Sanction 4 remove any existing installation of Sanction 3.x by using the

Programs and Features control panel. Then delete the folder Sanction 3.x was installed in. 

By default, the installation folder is: C:\Program Files (x86)\LexisNexis\Sanction 4\.

Sanction 4 requires the following components:

Microsoft® .NET® Framework 4.5.1 Web. This component is required for Sanction to run. If this

is not already installed on your computer, Sanction will prompt you to install it as the first step
of the installation process. To learn more about this component, visit the Microsoft .NET
Framework 4 (Web Installer)  page at Microsoft.com.

Microsoft Expression® Media Encoder 4, with Service Pack 2. This component is required for

Sanction to export clips and playlists. Sanction provides this as an optional component during
the install process. To learn more about this component, visit the Microsoft Expression Encoder
4 with Service Pack 2 (SP2) page at Microsoft.com. 

To install Sanction

1. Double-click the Sanction installation file. 

You may be prompted to install Microsoft .NET Framework 4.5.1 (Web Installer). If this

happens, it is highly recommended that you close all other programs before continuing the
installation process. After other programs are closed, click Install. 

This will start the download and installation process by Microsoft. You will be guided through

the .NET Framework installation. At the end of the install process of .NET Framework, you will
be prompted to restart your computer. After you restart and log in to your computer, the
Sanction installer will continue automatically.

2. In the Welcome screen of the installer, click Next.

3. In the License Agreement dialog box, review the terms of the license agreement. Click Print if
you want to print a copy of the license agreement.

4. If you accept the terms, click I accept the terms of the license agreement and then click
Next.

http://www.microsoft.com/en-us/download/details.aspx?id=17851
http://www.microsoft.com/en-us/download/details.aspx?id=17851
http://www.microsoft.com/en-us/download/details.aspx?id=27870
http://www.microsoft.com/en-us/download/details.aspx?id=27870
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5. In the Choose Destination Location dialog box, click Next to install to the default folder, or
click Change to select a different folder. 

6. Click Install.

8. In the InstallShield Wizard Completed dialog box, click Finish.

9. Click Finish.

Sanction is installed and ready to start for the first time. 

To start Sanction, click the Start menu, click All Programs, click LexisNexis CaseMap
Suite, and then click LexisNexis Sanction. 

When you start Sanction for the first time, you are prompted to activate your installation. For
more information on activating Sanction see: Activating Sanction. 

To uninstall Sanction

1. Close Sanction.

2. Double-click the Sanction installation file. 

3. When the InstallShield Wizard opens, click Next.

3. In the Program Maintenance dialog box, click Remove. 

4. Click Remove. 

If Sanction was not already closed before running the installation file, a Files in Use dialog box
opens. If this happens, click Cancel, close Sanction, and then restart this procedure.  

5. Click Finish.

Related Topics

System requirements

Activating Sanction

Repairing Sanction

Create, Open, and Pin Cases

Sample Sanction Case

Repairing Sanction

You can repair an installation of Sanction. This might be necessary, if for example, a Sanction
program file is moved or deleted.

To repair an installation of Sanction

1. Double-click the Sanction installation file. 

2. When the InstallShield Wizard opens, click Next.
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In the Program Maintenance dialog box, the option to repair Sanction is already selected. 

3. Click Next and then click Install. 

4. Click Finish.

Sanction is re-installed and ready to start again. 

When you start Sanction after repairing in, you are prompted to activate your installation. For
more information on activating Sanction see: Activating Sanction. 

Related Topics

System requirements

Installation

Activating Sanction

System Requirements

The minimum and recommended system requirements are listed as follows.

System Requirements

Category  Minimum Recommended

Operating system
Windows® 7 Service Pack 1 for
32 bit processor

Windows 7 Service Pack 1
for 64 bit processor

Software

During the installation process, Sanction will install the following
components if they are not already installed on your
computer:

Microsoft® .NET® Framework version 4.5.1 (Web Installer)

This component might require you to restart your
computer. 

If you want to install this component on your own. prior to
installing Sanction, you can download it from

Microsoft.com. To learn more, visit the Microsoft .NET®

Framework page at Microsoft.com.

Microsoft Expression® Encoder 4, Service Pack 2 

If you want to install this component on your own, prior to
installing Sanction, you can download it from
Microsoft.com. To learn more, visit the Microsoft Expression
Encoder 4 with Service Pack 2 (SP2) page at
Microsoft.com. 

Media player

Windows® Media Player 12

For more information or to download, visit the Get Windows
Media Player 12 page at Microsoft.com.

http://www.microsoft.com/en-us/download/details.aspx?id=30653
http://www.microsoft.com/en-us/download/details.aspx?id=30653
http://www.microsoft.com/en-us/download/details.aspx?id=30653
http://www.microsoft.com/en-us/download/details.aspx?id=27870
http://www.microsoft.com/en-us/download/details.aspx?id=27870
http://windows.microsoft.com/en-us/windows/download-windows-media-player
http://windows.microsoft.com/en-us/windows/download-windows-media-player
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System Requirements

Category  Minimum Recommended

Processor
2 GHz 2 GHz Intel Core 2 Duo or

higher

Memory (RAM) 2 GB 4 GB

Disk space
250 MB for Sanction program
files

1 GB or more

Additional disk space is required if, prior to installing
Sanction, these components are not already installed on
your computer: 

Microsoft Expression Encoder 4 SP 2 (2GB)

Microsoft .NET Framework 4.5.1 (850 MB for x86

processor; 2 GB for x64 processor).

Monitor 1024 x 768 1280 x 800 or higher

Related Topics

Installing Sanction

System requirements

Activating Sanction
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Cases

Change the Default Case Path

By default, Sanction saves cases in: C:\Users\UserName\Documents\LexisNexis\Sanction, where
UserName is the Windows user name of the current user.

You can reconfigure the default case folder so that when you open an existing case or create a new
case, Sanction opens the folder path of your choosing. Many find it helpful to change the default
folder to a shorter path, for example, to C:\Cases. 

To change the default folder path for cases

1. On the FILE tab, click Options. 

2. In the Default Cases Directory area, click the file path.

3. Navigate to the folder where you want to save your cases and then click Select Folder. 

We strongly recommend you set the default case path to a folder on your local computer,
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rather than to a network path or to a mapped network drive. Saving cases to a network can
corrupt backup case files. 

Related Topics

Moving Cases and Media Files

Configuring Preferred Media Paths

Create, Open, and Pin Cases

To get started in Sanction you create a case. It is highly recommended that when you create cases
on your local computer, rather than saving them to a sever. Working of a case file that is held on a
server can cause the backup file, which Sanction creates automatically, to become corrupt. 

Once you create a case, the next time you open Sanction you can find your case listed in Recent
Cases list, which is available from the Open area of the FILE tab. If you know you will be working on
the case and you do not want it to be replaced on the Recent Cases list, you can pin cases to the
Recent Cases list.

To create a case

1. Start Sanction.

If a case already open, click the FILE tab to access the case file panel.

2. Click Open, and then click New Case.

FILE > Open > New Case
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3. Browse to the folder where you want to save the case, type a name for the case file, and then
click Save.

The case is created and it opens in Sanction.

To open a case

1. Start Sanction.

If you already have a case open, click the FILE tab item to access the case file panel.

2. Click Open.

3. Do either of the following: 

Click Recent and then select a case from the Recent Cases list.

Click Browse, click Browse again, click the Sanction case file (.lns3), and then click Open.

To pin a case to the Recent Cases list

1. On the FILE tab, click Open, and then click Recent.

2. In the Recent Cases list, click the next to the case that you want always to appear in the list.

If you want to remove the case from the pinned cases list, click . 

Related Topics

Sample Sanction Case

Change the Default Case Path

Move Cases and Media Files

This topic discusses procedures and considerations related to using the Windows® file system to
move the actual source files of your case from one computer or device to another. 

If you want information on moving case items within the Sanction program, see: Moving Exhibits and
Media. And for information about moving the folders you create within Sanction, see: User Folders.

We strongly recommend you only work on case files housed on your local computer, rather than
working on a case you access on a network. Working on cases located on a network can
corrupt case backup files.

How Sanction files are organized in the Windows® file system

On the Windows® file system, a Sanction case consists of a case file, a case folder, a set of
subfolders within the case folder, and the files for various items in the case, such as exhibits,
media, and transcripts. 

These are described as follows: 

Case file. The case name is the same as the file name. The file name  ends with the .lns3

extension. 
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Case folder. Sanction creates a case folder with the same name as the case file, and in the

same folder location as the case file.

Case subfolders.  When the case folder is initially created, it contains three subfolders:

Exhibits, Transcripts, and Media.

Exhibits contains the exhibits you import the case, as well as screen captures, text clips, and

video stills that you create while working in your case.

Transcripts contains the transcripts you import into the case. The textual part of a

synchronized transcripts are also kept here but not the media. For more information on
synchronized transcripts, see: Synchronized Transcripts.

Media may contain some or all of the audio and video files for your case. When you import

media into your case, Sanction just creates a link to the media file. Sanction does not copy
the media to the case folder on the Windows file system, as it does when you import exhibits
and transcripts. 

To move a case to a different folder on the same computer

1. Click the FILE tab. 

2. If the case you want to move is open then click Close.

3. Select Open and then click Recent. 

4. If the file you want to move is listed in the Recent Cases list, then right-click the case and then
click Remove from list.

5. Switch from Sanction to Windows Explorer.

6. In Windows Explorer, open the folder that contains your case file (.lns3) and folder. The case file
and folder always have the same name. 

7. Use Windows Explorer to move the case file and folder to the destination folder.

The moved case can be opened in Sanction. 

To move a case to a different computer

     If your case includes video files that are located outside of the Sanction case folder, consider
running the Copy Video Files command prior to moving your case files. The Copy Video Files
command copies video files to the \Media folder of your case. 

      For more information, see: Copy Video Files to the Case Media Folder.

1. Close Sanction. 

2. In Windows Explorer, open the folder that contains your case file (.lns3) and folder. The case file
and folder always have the same name. 

By default, this folder for cases is: <User's Documents Folder>\LexisNexis\Sanction\. To learn
more about viewing or changing the current location for cases, see: Change the Default Case
Path.

3. Use Windows Explorer to move or copy the case file and folder from the source computer to a
removable drive and or other storage media.

4. Copy the case file and folder from the removable drive or transfer device to the destination
computer. If the source and destination computer are networked, it may be possible to transfer
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the case file and folder across the network without a removable drive.

5. On the source computer, if any case media files for the case were stored outside of the case's
Media folder, do the following:

Copy or move the media files from the source computer to a folder on the destination

computer. 

Update preferred media paths in the case as needed to reflect changed paths to the media.

For more information on working with preferred media paths, see: Preferred Media Paths. 

Main considerations

When you move a case, remember these tips:

Always keep the case file and the case folder together in the same folder.

Do not change the name of the case file or the case folder.

Do not change the contents of the case folder.

For media stored outside of your case \Media folder, make sure to move it too. To help

prevent video from being left on the source computer, you can run the Copy Video Files
command prior to moving case files. For more information see: Copy Video Files to the Case
Media Folder.

If you choose not to copy the video and other media files to the \Media folder of your case,

after the case is moved, make sure to register the new path to the media as a preferred media
path. For more information, see: Preferred Media Paths. 

Related Topics

Change the Default Case Path

Configuring Preferred Media Paths

Preferred Media Paths

Copy Video Files to the Case Media Folder

Practice with a Sample Case

With the Sanction sample case, you can begin experimenting with the features of Sanction. You can
reset the sample case to its original state whenever you want to. 

To open or reset the sample case

1. On the FILE tab, click Open. 
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2. Select Sample Case.

3. Select one of the following depending on what you want to do:

Open opens the sample case in the state it was in when you last closed it. 

Refresh opens the sample case in its original state.

Related Topics

Create, Open, and Pin Cases

Quick Start Guide

Navigating Sanction

Customizing the Layout

Preferred Media Paths

Default Folders and Item Types

User Folders
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Items and Folders

Default Folders and Item Types

When you create a case, several default folders are visible in the folder list. This topic describes these
folders, the kinds of items each can contain. 

By default, Sanction creates the following high-level folders for each case: Exhibits, Media, Playlists,
Transcripts, and Presentations.

To disambiguate, the folders described in this topic relate to the set of folders and subfolders
that you see when you open a case in Sanction. For information about Sanction folder structure
in the Windows file system, see: Moving Cases and Media Files.

The Exhibits Folder

You can add PDFs and image files to the Exhibits folder and its subfolders, either by importing files or
by creating new screen captures, text clips and media stills from within Sanction.  

The Exhibits subfolders are:

By default, the Exhibits folder contains a Documents folder and an Images folder.

Documents. This folder is provided as an initial storage location for exhibit documents. You can

create additional folders within the Documents folder. 

Images. This folder is provided as an initial storage location for images. However, the Images

folder also contains several default subfolders of its own, with each serving a specialized purpose:

Captures. This folder is where Sanction puts any screen captures that you create. In Sanction,

a screen capture is an image that you can create while viewing an exhibit either in the exhibit
viewer or in the presentation window. For more information, see: Screen Captures.

Text Clips. This folder is where Sanction puts any text clips that you create. A text clip is a kind

of image that you create in Sanction from the text you select while viewing a transcript. For
more information, see: Text Clips.

Timelines. This folder is designated to hold timeline images, such as those created in LexisNexis

TimeMap®.

Video Stills. This folder is where Sanction puts any video stills that you create. A video still is an

kind of image that you can create in Sanction when using the video player. For more
information, see: Video Stills.

The default folders do not enforce any file management scheme. For example, there is nothing to

prevent you from putting image files into the Documents folder or PDF files into the Images
folder.

In addition to the default folders, you can create custom folders anywhere within the Exhibits

folders. 
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You can apply annotations to any item in the Exhibits folder and its subfolders. 

The Media Folder

The media folder may contain individual audio files and video files that you import, plus any clips
that you make from them in Sanction after import. By default, the Media folder contains a Videos
subfolder, which is provided to help you organize the media you import initially. Like the Exhibits
folder, you can create your own folders under the Media folder. For information on getting media
into your case, see: Importing Media.

Playlists

A playlist is a series of media clips that you assemble within Sanction to form a single media piece.
For more information on creating media clips, see: Media Clips. For information on assembling
clips into playlists, see: Playlists.

Transcripts

Sanction supports many common transcript formats. After you import a transcript, it is accessible
via the Transcripts navigation bar. For information on getting transcripts into your case, see: 
Importing Transcripts.

Presentations

This folder holds the presentations you create, as well as the Default Presentation, which is built
into Sanction and contains no items initially. For information about creating presentations, see: 
Create a Presentation.

Related Topics

User Folders

Moving Exhibits and Media

Screen Captures 

Text Clips

Video Stills

Overview of Importing

Deleting Items
Deleting an item removes it from the case. If you want to delete an item, here are some
considerations to keep in mind.

Deleting Exhibits

When you delete an exhibit, any annotations that you have applied to it are deleted as well, and

the exhibit is removed from any presentations it was added to. However, any screen captures
you may have created from the exhibit. as well as any annotations made to the screen capture
are not deleted. 

Exhibit pages cannot be deleted independently from the exhibit to which they belong.

Deleting Media

Deleting a media item from within Sanction does not delete the media source file from the file

system, it just breaks the link from the case to the media file. 

When you delete a media item from Sanction, any clip that you created from the media item is

also deleted from the case. This includes clips already added to presentations and playlists.
However, video stills created from the media item are not deleted nor are any annotations
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applied to the video stills. 

Deleting Transcripts

When you delete a text transcript, it is removed from the case. But like the screen captures from

exhibits and video stills from media, any text clip made from the deleted transcript remains as an
exhibit in the case. When you delete a transcript from the case, it is removed from any
presentations it was added to. 

When you delete a synchronized transcript, the transcript is removed from the case, but the

video remains in its Sanction folder.

Deleting Playlists, Presentations, and Folders

If you delete a playlist, the items that were a part of it remain in the case. 

To remove an item from a presentation, select the item and use the Remove Item command.

Ctrl+Alt+R. Do not use the Delete command when a presentation item is selected as doing so
will delete the entire presentation.

If you delete a presentation, the items that were a part of it remain in the case. 

You can delete any folder that you create, as long as the folder does not contain any items.

To delete items

1. On the HOME tab, click the Exhibits, Media, Transcripts, or Presentations navigation bar,
depending on the type of item you want to delete. 

2. Select the item you want to delete.

Items, such as exhibit pages and transcripts, are not deleted from presentations, they are
removed. Accordingly, if you want to remove an item from a presentation, you must select
the item then then click Remove Item. Do not use the Delete command to remove items
from presentations as doing so will delete the presentation.

3. Do one of the following:

In the Actions group, click Delete.

Right-click the item and then click Delete.

Press Ctrl+D.

4. In the confirmation dialog box, click Yes. 

Related Topics

Moving Exhibits and Media

Default Folders and Item Types

Editing Item Properties

A property is a type of information about an item. Item name, exhibit number, and description are all
examples of properties.

Additionally, the following facts pertain to item properties:

Each item type supports a different set of properties. For example, presentations have just the 

name property, whereas videos, in addition to the name property, have exhibit number, trial
exhibit number, admit date, description, and file name.

Certain item properties are editable and others are not. For example:

For videos, all properties but file name can be edited. 

For transcripts, all but the page count property can be edited. 
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The name property of most items can be edited by right-clicking the item and then selecting

Rename or Edit. Note that exhibit names are editable, but not the names of individual exhibit
pages.

Other properties, when they apply, can be accessed via the Edit command. Select the item you

want to change the property for, and then, on the HOME tab, click Edit. Note that although
names of exhibits are editable, but not names of individual exhibit pages.

For exhibits, in addition to the manual methods for editing their properties, several wizards are

available for bulk renaming and renumbering. For more information see: Wizards for Renaming,
Renumbering, and Bates Numbering.  

To rename an item

1.Select the item that you want to rename.  

2.Do any of the following:

Right-click the item, and then click Rename.

On the HOME tab, in the Actions group, click Rename. 

On the HOME tab, in the Actions group, click Edit.

Press F2.

3. Type the new name and then press Enter.

To edit or view other item properties

1.Select the item whose properties you want to view or edit.

2.Do one of the following:

On the HOME tab, in the Actions group, click Edit.

Right-click the item, and then click Edit.

Press Ctrl+Shift+I.

The item properties dialog box opens.

3.View or edit properties as provided by the dialog box, and then click OK.

Related Topics

Wizards for Renaming, Renumbering, and Bates Numbering

Searching for Case Items

Moving Exhibits and Media

You can move exhibits and media items along with associated clips from one Sanction folder to
another.

This topic applies to moving items between Sanction folders. To learn about moving the files for a
case on the Windows file system, see: Moving Cases and Media Files.

To move exhibits or media items

1. Click the Exhibits or the Media navigation bar, depending on which type of item you want to
move. 
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2. Select one or more items and then do one of the following:

On the HOME tab, click Move.

Right-click the items and then click Move.

Press Ctrl+Shift+F2.

3. Select the destination folder and then click OK. 

It is not possible to move individual pages or images of an exhibit independently of the exhibit
itself. Only the entire exhibit can moved.

Related Topics

Moving Cases and Media Files

User Folders

Deleting Items

User Folders

You can create new folders within the Exhibits or Media folders, and then import or move items into
the folders you created. You can also rename, move, or delete the folders you create. The folders
you create can be nested within other folders, including the default folders that Sanction creates. 

To create a folder

1. On the HOME tab, click either the Exhibits or Media navigation bar, depending on the type of
item the folder will hold.

2. In the New group, click New Folder or press Ctrl+Shift+F3.

The Create New Exhibit Folder dialog box opens. 
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3. Type a name for the folder and then select a destination folder.

4. Click OK. 

The new folder is created in the folder that you selected.

To rename, move, or delete a folder

1. Select the folder.

2. Select an option, depending on what you want to do:

Option Steps

Rename
1. Click Rename Folder. 

2. Type the new name for the folder and then press Enter.

Move
1. Click Move Folder.

2. Select the new folder location and then click OK. 

Delete

Click Delete Folder. 

To delete a folder, it must be empty.
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If the folder options are shaded, it means that one of the default Sanction folders is selected. The
default folders cannot be renamed, moved, or deleted. 

For more information on the default folders, see: Default Folders and Item Types.

Related Topics

Default Folders and Item Types

Deleting Items

Moving Cases and Media Files

Moving Exhibits and Media



Sanction 4.0
User Guide

®

Importing

6



Importing 59

© 2015 LexisNexis. All rights reserved.

Importing

Overview of Importing

With Sanction, you can import common file formats used in courtroom presentations for exhibits,
media, and transcripts. 

This topic lists the file types you can import into Sanction and the  folder that holds each type of file.
This topic also describes the options you have for importing exhibits and media files singly or by the
folder. The manner in which Sanction handles importing duplicate files is also described.

Supported file formats and their destinations

You can import many common file formats into your case by using the import utility from either
FILE > Info > Import, or HOME > Import. Or you can drag and drop exhibits or media items
directly on the folders where you want these items to go. 

For each file format, a specific area of the item tree is reserved as a destination. 

These file formats: Can be imported into this folder:

Bitmap .bmp

Gif .gif

Jpeg .jpg, .jpeg

Portable Document Format .pdf

Png .png

Tif .tif, .tiff

Exhibits and subfolders

Video .avi, .mpg, and .wmv.

 Note that the .mov format is also supported but
requires Apple QuickTime® for replay.

Audio .mp3, .wav. wma

Media file formats other than those listed here,
for example MP4 video, may also be imported.
However playback of these files may require
additional codecs to be installed on your
computer. For more information about codecs for
Windows® Media Player 12 and Windows 7,
see the Windows 7 Codec FAQ page.

Media and subfolders

Text .txt

Portable transcript .ptf

TextMap® Evidence Format .xmef

TextMap Portable Transcript .xmptf

Transcripts list

http://windows.microsoft.com/en-us/windows/codecs-frequently-asked-questions#codecs-frequently-asked-questions=windows-7
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These file formats: Can be imported into this folder:

Sanction MDB .mdb

 

What can prevent a file from being imported?

Sanction prevents incompatible file types from being imported. A file is prevented from import in
cases where the file is:

Corrupt.

Password protected.

Unsupported for the type of item you are trying to import.

If you try to import a set of files that contains incompatible files, Sanction will proceed with the
import of compatible files and provide notification that some files were skipped. For example, if you
run the Exhibit Import Wizard and include a folder that contains a mixture of PDFs, plain-text
transcripts and media files, only the PDFs will imported into the Exhibits folder.

What happens when I import duplicates?

If you import a file with the same file name as one you already imported, Sanction adds "-dup" to
the name of the newly imported item. 

This rule holds across the entire case independently of file extension. For example, if a transcript file
named MyFile.txt is imported as a transcript, it will appear in the transcript list as MyFile. After that,
if a different transcript file named MyFile.mdb is imported, it will appear in the list as MyFile-dup. If
a third file in then imported, this time an exhibit named MyFile.pdf, it would list in the Exhibits folder
as SomeDeposition-dup(2). 

Related Topics

Importing Exhibits

Importing Media

Importing Transcripts

Importing Exhibits

To import exhibits, you can either drag and drop them into the Exhibits tree in Sanction, or you can
run the Exhibit Import Wizard, which is available from FILE > Info > Import or from HOME >
Import. To import a series of scanned files as one exhibit, use the Exhibit Import Wizard. 

Any files that are not PDF or image files are automatically omitted from being imported.  

If you import folders, Sanction creates new folders in the Exhibits tree that mirror those you import.

When you import files, Sanction copies the source files to your case.The import process does not
move or change the source files in any way. 

File and page naming conventions

When you import exhibits, Sanction assigns a name to each exhibit and exhibit page. It also
numbers the exhibit pages. Naming and numbering are determined as follows:



Importing 61

© 2015 LexisNexis. All rights reserved.

The exhibit name is drawn from the file name without the file extension. For example, a file

named BalanceSheet.pdf, when imported would appear in the exhibit list as BalanceSheet.

Page names consist of the exhibit name followed by a dash (-) separator and a page number.

The exception to this is the first page, which is composed only of the name of the exhibit
without the separator or number.

Page numbering reflects the page count of the original document.

After the import, you can change exhibit properties, such as name, page numbers, Bates

numbers, and more. For more information about changing exhibit properties individually, see:
Editing Item Properties. For more information changing multiple exhibit properties at one time,
see: Wizards for Renaming, Renumbering, and Bates Numbering.

Combining multiple files into one exhibit

By default, when you import a set of image files, each file is imported as an individual exhibit.
However, when you use the Exhibit Import Wizard, you are given the option to combine all the
image files you are importing into a single exhibit. The option to combine files is not available via
drag and drop import. 

Combining files is an all-or-nothing operation. When you run the Exhibit Import Wizard, and you
select the option to combine files into one exhibit, all of the files imported in that import session
are combined. When you use the option to combine files, take care to include only files that all
belong to that one exhibit. 

Example

Suppose Alice wants to import 3 exhibits. Two of the exhibits are multi-page PDF files:
Contract_A.pdf and Contract_B.pdf. The third exhibit, is a scanned report comprised of several TIF
files. To be certain that each exhibit retains its identity as a separate exhibit in the case, Alice runs
the import wizard twice. 

The first time she runs the import wizard, she selects just the two PDFs. After the import, each
PDF appears in the exhibit folder as a separate exhibit.

The second time she runs the import wizard, she selects the TIF files. Because all the TIF files
belong to the same exhibit, in the import wizard she uses the option to combine all the files into
one exhibit. After the import, all of the TIF files are combined into a single exhibit.

To import exhibits by using drag and drop

1. With a case open, click the Exhibits navigation bar.
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The Exhibits folders are listed.

2. Drag and drop exhibit files or folders into a folder on the Exhibits tree.  

A dialog box confirms the file import by providing a count of the number of files that were
imported and notes if any files were not imported. If you dropped folders, Sanction creates new
folders in the Exhibits tree that mirror those you dropped. 

3. Do one of the following:

To finish the import without numbering or renaming, click Close.

To renumber the exhibits, click Launch Exhibit Numbering Wizard, then follow the steps in

the wizard.

To rename the exhibits, click Launch Exhibit Renaming Wizard, then and follow the steps

in the wizard 

For more information on renaming and renumbering, see: Wizards for Renaming,
Renumbering, and Bates Numbering.

To import exhibits by using the import wizard

1. With a case open, do one of the following:

Press Ctrl+I.

On the FILE tab, click Info, click Import, and then click Exhibits. 

On the HOME tab, click Import. and then click Exhibits. 

The Exhibit File Import Wizard starts.
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2. Click Next. 

The Select Files to Import dialog box opens.
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3. Open the folder that has the exhibits that you want to import.

4. Do either of the following, depending on what you want to import. 

Click Add All to add all the listed items.

Select individual files or folders and then click Add Selected. 

After adding items, you can remove them as needed from the queue. To remove one or

more items, CTRL+click or SHIFT+click items and then click Remove Selected. To
remove all items, click Remove All.

Items that are ready to be exported and are listed in the right panel of the dialog box.

5. Click Next. 

6. Add more items or remove items from the list as needed. 
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7. When your list contains all the files you want to import, click Next.

The Select Import Destination Folder dialog box opens.
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8. Select a destination folder and then click Next. If necessary, you can click New Folder and then
create a new folder to use as the import destination.

9. This step depends on whether you have selected a single file for import or multiple files.

If all of the files selected for import are image files, the Combine Files dialog box opens. 

Do one of the following, depending on whether the files should all be combined into a single
exhibit.

Click Yes only if all the files belong to the same exhibit. 

Keep the default as No, and then click Next if each file represents a different exhibit.

Click Cancel and then restart the wizard if some of the files should be combined and others

should not.
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The Ready to Import dialog box opens.
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10.Review the summary of your import selections. If the file list and destination folder are all right,
then click Next. 

The import proceeds. When completed, the Import Confirmation dialog opens. If any error
occurred during import, it is noted on the dialog box. 
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11.Do one of the following: 

Select Launch Exhibit Renaming Wizard then follow the steps in the wizard to rename the

exhibits you just imported. For more information, see: Wizards for Renaming, Renumbering,
and Bates Numbering.

Click Close.

The files are added to the case in the folder you selected.

To import exhibits by using a load file

With Sanction, you can bring exhibits into your case by importing load files formatted as Opticon
.LOG or as IPro LFP. 

1. With a case open, do one of the following:

On the FILE tab, click Info, click Import, and then click Exhibits. 

On the HOME tab, click Import, and then click Exhibits.
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2. In the Welcome dialog box, click Next.

The Select Files to Import dialog box opens.

3. Click Add File and then browse to the exhibit load file. 

4. Select the load file and then click Load.

The Select Files to Import dialog box opens again. 

5. Click Add File and then select a load file, or click Next to continue with the wizard.

6. Select the folder where you want to save the exhibits. 

If you want to create a new folder, then click New Folder, type a name for the folder, select

a destination folder, and then click OK.

The Ready to Import dialog box opens.

7. Verify your selection and then click Next.

The Import Confirmation dialog box opens, which provides a count of the files that were
imported.

8. Click Close.

To import multiple image files as a single exbhit

1. With a case open, do one of the following:

On the FILE tab, click Info, click Import, and then click Exhibits. 

On the HOME tab, click Import. and then click Exhibits.
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The Exhibit File Import Wizard starts.

2. Click Next. 

The Select Files to Import dialog box opens.
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3. Open the folder that has the image files that you want to import as a single exhibit.

4. Do either of the following, depending on what you want to import. 

Click Add All to add all the listed items.

Select individual files or folders and then click Add Selected. 

After adding items, you can remove them as needed from the queue. To remove one or

more items, CTRL+click or SHIFT+click items and then click Remove Selected. To
remove all items, click Remove All.

Items that are ready to be exported and are listed in the right panel of the dialog box.

5. Click Next. 

6. Add more items or remove items from the list as needed. 
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7. When your list contains all the files you want to import, click Next.

The Select Import Destination Folder dialog box opens.
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8. Select a destination folder and then click Next. If necessary, you can click New Folder and then
create a new folder to use as the import destination.
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9. Click Yes, combine the selected files..., and then click Next. 

 The Ready to Import dialog box opens.
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10.Review the summary of your import selections. If the file list and destination folder are all right,
then click Next. 

The import proceeds. When completed, the Import Confirmation dialog opens. If any error
occurred during import, it is noted on the dialog box. 
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11.Do one of the following: 

Select Launch Exhibit Renaming Wizard then follow the steps in the wizard to rename the

exhibits you just imported. For more information, see: Wizards for Renaming, Renumbering,
and Bates Numbering.

Click Close.

The files are added to the case in the folder you selected.

Related Topics

Overview of Importing

Importing Media

Importing Transcripts

Wizards for Renaming, Renumbering, and Bates Numbering 

Moving Exhibits and Media

Adding and Removing Items

Importing Media

You can import video and audio files into your case. 

There are two ways to import media. You can either drag and drop folders and files directly into a
folder in the Media area, or you can run the Media Import Wizard, which is available from FILE >
Info > Import or from HOME > Import. 
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If you import folders of media items, Sanction creates new folders in the Media tree that mirror those
you import.

To import exhibits by using drag and drop

1. With a case open, click the Media navigation bar.

The Media folders are listed.

2. Drag and drop files or folders into any folder in the Media tree, except Playlists. 

A dialog box confirms the file import by providing a count of the number of files that were
imported and notes if any files could not be imported.  

3. Click Close to finish the import.

To import media by using the import utility

1. Do one of the following:

Press Ctrl+I.

On the FILE tab, click Info, click Import, and then click Media. 

On the HOME tab, click Import. and then click Media. 

The Media File Import Wizard starts.
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2. Click Next. 

The Select Files to Import dialog box opens.
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3. Click Add Files or Add Folder, depending on whether you want to select files individually or by
the folder. 

Option Perform these steps

Add files individually

1. Click Add Files.

2. Browse to the folder that has files you want to add.

3. Select one or more files, and then click Open.

Add a folder with or
without its
subfolders

1. Click Add Folder.

2. Browse to the folder that has files you want to add.

3. Click Select Folder.

4. Add more items or remove items from the list as needed. When your list contains all the files
you want to import, click Next.

The Select Import Destination Folder dialog box opens.
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5. Select a destination folder and then click Next. If necessary, you can click New Folder and then
create a new folder as a destination for the import.

The Ready to Import dialog box opens.
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6. Review the summary of your import selections. If the file list and destination folder are all right,
then click Next. 

The import proceeds. When completed, the Import Confirmation dialog opens. It provides a
count of the number of transcripts that were imported. Any error that occurred during import is
noted on the Import Confirmation screen. 
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7. Click Close.

The files are added to the case in the folder you selected.

Related Topics

Overview of Importing

Importing Exhibits

Importing Transcripts

Moving Exhibits and Media

Preferred Media Paths 

Adding and Removing Items

Importing Transcripts

You can import transcripts, including synchronized transcripts into your case. 

There are two ways to import transcripts into your case. You can either drag and drop transcripts
directly into the transcripts list, or you can run the Transcripts Import Wizard, which is available from 
FILE > Info > Import or from HOME > Import.

To import exhibits by using drag and drop

1. With a case open, click the Transcripts navigation bar.
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2. Drag and drop transcripts individually or by the folder to the list area just above the navigation
bars.  

A dialog box confirms the file import by providing a count of the number of transcripts that
were imported and notes if any were skipped. 

3. Click Close.

To import transcripts by using the Import Wizard

1. With a case open, do one of the following:

Press Ctrl+I.

On the FILE tab, click Info, click Import, and then click Transcripts. 

On the HOME tab, click Import. and then click Transcripts.

The Transcript File Import Wizard opens.
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2. Click Next.

The Select Transcript Files to Import dialog box opens. 

3. Click Add Files and then browse to the folder where the transcripts are located. Select the
transcripts you want to import and then click Open. The transcripts you selected are listed in
the dialog box. Repeat this step as needed to select more transcripts.

4. Click Next.

The Ready to Import dialog box opens.

5. Click Next.

The selected transcripts are imported and the Import Confirmation dialog opens displaying a
count of imported transcripts. 

6.  Do one of the following: 

For this condition: Perform these steps:

None of the transcripts
you imported were
synchronized transcripts.

Click Close. 

One or more of the
transcripts you imported
are synchronized
transcripts.

AND 

The media files for the
synchronized transcripts
have not been added to
the Media folder for the
case in the Windows file
system.

1.Click Select Media Paths. The Case Media Paths dialog box
opens.

2.Review the list of paths. 

3.Add paths as needed to make sure each media file can be
reached along a path.

o If a path already exists to a folder that is positioned higher in

the file system hierarchy than the folder that contains
transcript media, then click Edit, click Include Subfolders, and
then click OK.

4.When finished adding paths, click OK to finish working in the
Case Media Paths dialog box.

5.Click Close to complete the Transcript File Import Wizard.

7. If any of the transcripts you imported are synchronized transcripts click the Select Media
Paths button and then do the following:

For each synchronized transcript listed, make sure there is a media path. 

If any path that is missing, click Add, click Browse and then select the folder that contains the

media. If you want to select a folder at a higher level, such as the root of an external drive you
can click Include Subfolders. 
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If importing synchronized transcripts, at the end of the import wizard, click Select Media Paths and add paths to
the media files.

         

Related Topics

Overview of Importing

Importing Exhibits

Importing Media

Preferred Media Paths

Adding and Removing Items

Integration with LexisNexis TextMap
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Exhibits

Add or Replace Exhibit Pages

You can replace an existing exhibit with a different version of it. When replacing an exhibit, the
replacement must be of the same file type as the original and must have the same number of pages.

You can also add pages to an exhibit or replace pages. When you add pages, the replacement pages
must be the same file type as the original.  Any annotations that you applied to the original page are
transferred to the replacement. 

To add pages to an exhibit

1. Navigate to the exhibit you want to change.

a. On the HOME tab, click the Exhibits navigation bar. 

b. Open the exhibit folder that contains the exhibit.

2. Do either of the following:

Click the exhibit, and then on the HOME tab, click Update Exhibit, and then click Add

Page(s).

Right-click the exhibit, click Update Exhibit, and then click Add Page(s). 

3. Navigate to the file that contains the exhibit pages you want to add.

4. Select the file and then click Open. 

In the Exhibit Viewer, the pages in the file that you selected are added to the end of the page
list.

To replace exhibit pages

1. Navigate to the exhibit you want to change.

a. On the HOME tab, click the Exhibits navigation bar. 

b. Open the exhibit folder that contains the exhibit.

2. Select the exhibit, and then on the HOME tab, click Update Exhibit.

3. Click Replace Page(s).
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4. In the message box that says that all the images for the exhibit will be updated, click OK. 

5. Navigate to the file that contains the exhibit pages you want to add.

6. Select the file and then click Open. 

The exhibit pages are updated with the pages of the exhibit you selected.

Related Topics

Importing Exhibits

Editing Item Properties

Annotation Tools

You can access annotation tools in the exhibit window via the IMAGE TOOLS tab, and from the
Presentation window via the Annotation Tools Gallery button. 

In the main program window, annotation tools are available in the IMAGE TOOLS tab 

in the Presentation window, annotation tools are available via the Annotation Tools Gallery button 

During a presentation, annotations made in the exhibit viewer of the main program window can
be made to be immediately visible in the Presentation window. Conversely, annotations made in
the Presentation window can be made to be immediately visible in the exhibit viewer. However,
for this reciprocity to work consistently, the annotation layer to which the annotation was
applied must be configured to be visible in both the exhibit viewer and the Presentation window.
For more information about annotation layers, see: Annotation Layers.

List of annotation tools

Annotation tools are available in the main window and in the presentation window. For a list of the
Keyboard shortcuts for annotation tools, see: Keyboard Shortcuts. The function of each
annotation tool is described here:
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Tool Description

Select
Selects annotations that have been added to the exhibit. 

Allows you to resize, reposition, and delete annotations.

Crop/Zoom

Zooms in on a rectangular area of the exhibit. 

Use this tool to draw attention to a part of the exhibit or in conjunction with the
Screen Capture tool to create a screen capture. For more information on screen
captures, see: Screen Captures. 

Tear Out

Creates floating zoom areas that can be resized, repositioned, or closed as
needed. Tear outs contains whatever annotations that were applied to the
exhibit as well as any that are created as the tear out is open. 

Dragging the mouse across the face of a tear out creates a highlighted area on
the exhibit.

The edge of tear outs can be set to smooth or to a ripped effect. 

For more information see: Tear Out Tool. 

Magnifier Creates a rectangular magnified area that can be moved around. 

Pan Moves the exhibit around in the exhibit window.

Erase Erases annotations, one at a time.

Highlight
Creates a translucent highlighted rectangle. The default highlight color is yellow
but it can be changed by selecting a different color from the Fill Color control.  

Arrow Creates an arrow. 

Line Creates a line.

Pen Creates a freehand line.

Rectangle Creates an unfilled rectangle.

Ellipse Creates an unfilled ellipse.

Redaction Creates a filled rectangle. 

Text

Allows you to type text onto the exhibit. The text box is bordered and can be
moved or resized. You can also set the default font and font style. To access
font settings, on the FILE menu, click Options, and then click Exhibits.

Note that this tool is available in the main program window only.

Line size and
Line color

Sets the line weight and color for arrows, lines, pens, rectangles, and ellipses. 

Fill color
Sets the fill color for the highlight, rectangle, and ellipse. 

Sets the background color for text.

Layers
Provides control over the visibility of annotations. For more information, see: 
Annotation Layers. 
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To annotate an exhibit from the IMAGE TOOLS tab

1. On the HOME tab, click the Exhibits taskbar. 

2. Select the exhibit you want to annotate.

3. Do one of the following:

Double-click the exhibit.

Select the IMAGE TOOLS tab. 

4. Annotate the exhibit by using the tools in the image toolbar. 

To annotate an exhibit from within the presentation window

1. In the presentation window, open the exhibit you want to annotate.

2. Select the annotation tool gallery button.

3. Select an annotation tool and then apply the annotation to the exhibit. 

To set defaults for annotation tools

1. On the FILE tab, click Options.

2. Click Exhibits.
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File > Options > Exhibits

3. Select options for annotation tools needed.

Tool Options

Image Tool
Select the default image tool as: Highlight, Arrow, Line, Pen, Rectangle, Ellipse,
Crop/Zoom, or Tear Out.

Annotation
Font

Change the default font, font size, and color of text annotations.

Tear Out

Change the default screen position of tear outs.

Change the default edge of the tear out from standard (smooth) to a ripped
edge.

PDF
Resolution

Increase the resolution of PDF pages. The default value is 96 DPI, with stops at
150, 200, and 300.

4.  Click OK. 

You can also access Sanction options from the presentation window. In the presentations
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window, select the presentation options button. 

To delete all annotations

You can delete all the annotations applied to exhibit pages in one operation. When you delete
multiple annotations in this way, you can choose whether to include or exclude exhibit stamps in
the delete operation.

 Select the exhibit or exhibit pages that you want to remove annotations from. 

1. Do either of the following:

Right-click the selected exhibit or exhibit pages and then click Delete Exhibit Page

Annotations. 

Click the IMAGE TOOLS tab, and then click Delete Annotations.

2. Click one of the following, depending on what you want to do:

Select this option: To accomplish this:

Delete All Exhibit
Page
Annotations

Delete all annotations, including any exhibit stamps.

Delete All
Excluding
Stamps

Delete all exhibits, but keep exhibit stamps.

Delete Only
Stamps

Delete all exhibit stamps, but keep all other annotations.

3. In the confirmation box, click Yes.

The annotations and/or stamps are deleted.

Related Topics

Annotation Layers

Tear Out Tool

Rotate Pages and Images

Annotating in Real Time

Annotation Layers

By applying annotations in layers, you can control the visibility of selected annotations, showing them
or hiding them as needed to suit the particular needs of your presentation. Annotation layers can be
controlled both from the main program window and from the presentation window. This topic
describes concepts and procedures that apply mainly to working in the main program window. For
more information about working with annotation layers while in the presentation window, see: 
Annotating in Real Time. 
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When you want to apply annotations in layers, consider the following:

Number of layers = 9. Each exhibit has 9 layers. Each layer may hold multiple annotations.

Layer 1 is always visible. Layer 1 is the only layer that cannot be hidden. Annotations applied

to Layer 1 is always visible in both the exhibit viewer and in the presentation window. Note that
exhibit stamps are applied only on Layer 1 so they are always visible.

Layers 2-9 can be set to visible or hidden. At any given time, Layers 2 through 9 can be set

individually to visible or hidden. 

You can control visibility in main window and presentation window. Control over layer

visibility is provided in both the main program window and in the presentation window. However,
note that visibility of individual layers is set independently between the two windows. For
example, you can set Layer 2 to be visible in the main program window and hidden in the
presentation window. 

Initial visibility of layers. Initially, in the main program window, all layers are visible. But in the

presentation window, Layers 2-9 are initially hidden. 

Reciprocal visibility. Annotations applied from either window are immediately visible in the other

window as long as the layer to which the annotation is applied is set to visible in both windows.

Moving away from an exhibit. In the presentation window, moving away from an exhibit hides

all layers except Layer 1.

To use annotation layers from the main program window

1. Select the Exhibits navigation bar.

2. Select the page of the exhibit you want to annotate.

3.  Select the IMAGE TOOLS tab. 

In the Layers area, Layer 1 is selected by default.

 

Until another layer is selected, all new annotations are applied to Layer 1.

4. Add any annotations you want to appear at all times to Layer 1. 

Annotations placed on Layer 1 cannot be hidden. 

5. Select Layer 2 and then apply annotations to the exhibit. In the presentation window, these
annotations will be hidden initially.

6. Select the eye icon next to the layer 2 to show or hide the layer.  
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7. Add more annotations to other layers as needed.

8. Practice presenting the exhibit, manipulating the visibility of layers until you are comfortable with
how they look. Several keyboard shortcuts are available for use with annotation layers. For
more information, see: Keyboard Shortcuts.

As an alternative to working with layers can also create multiple copies of the same exhibit page
and then apply different annotations to each copy. For more information, see: Save as New
Page. 

Related Topics

Annotation Tools

Tear Out Tool

Annotating in Real Time

Keyboard Shortcuts

Exhibit Stamps

You can apply exhibit stamps to exhibit pages. Exhibit stamps can be configured in the following
ways:

Color. You can color your stamps as either blue, red, white, or yellow.

Optional fields. You can add one of the following fields to exhibit stamps: page name, exhibit

number, trial number, or Bates number. In addition, you can also add a case number of up to 25
characters. 

Placement. You can select where on the page margin to apply the stamps. After stamps are

applied, they can be moved around on the page individually.

Size. After stamps are applied, you can change their size individually.

FILE > Exhibit Stamp Wizard

After you have applied the stamps, you can move, resize, or delete them individually via the exhibit
viewer or from within the presentation window. 

Stamps are applied to Layer 1 so they cannot be hidden when presenting the exhibits. As with other
annotations, exhibit stamps do not appear on exhibit printouts. However, exhibits stamps can be
made to appear on exported exhibits. For more information on exporting exhibits see: Exporting
Exhibits, Media Clips, and Playlists.

To apply exhibit stamps

1. In the Info area of the FILE tab, click Exhibit Stamp.
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2. In the Welcome dialog box, click Next.

The exhibit selection dialog box opens. 

3. Select items to stamp. 

Click Add All to add all the listed exhibits.

Select individual exhibits and then click Add Selected. 

Double-click individual exhibits.

After adding exhibits, you can remove them from the queue as needed. To remove one or

more exhibits, CTRL+click or SHIFT+click items and then click Remove Selected. To
remove all exhibits, click Remove All.

The exhibits to be stamped are listed in the right panel of the dialog box.

4. Click Next. 

5. Select options as needed:

Stamp type. This determines the title and color of the stamp.

Field. The following fields are available: page name, exhibit number, trial number, or Bates

number.

Case Number. You can enter up to 25 characters in this field.

Placement. Select a radio button to position stamp on the page.



Exhibits 97

© 2015 LexisNexis. All rights reserved.

The default placement is bottom edge of page, centered.

Click Apply Exhibit Stamp to the first page only to have the stamp applied that manner.

6. When options have been selected, click Next.

The Ready dialog box opens.

7. Review your selections and then click Next.

The exhibits are applied and the Exhibit Stamp Wizard Complete dialog box opens.

8. Click Close.

To move, resize or delete exhibit stamps

1. Open the exhibit in the presentation window or exhibit viewer.

2. Do one of the following:

To move the stamp. drag the stamp to a different part of the page.

To resize the stamp, select the stamp and then click and drag the exhibit stamp handles. 

To delete a stamp, select it and then press the Delete key.

To delete all exhibit stamps

1. Select the exhibit or exhibit pages that you want to remove stamps from. 

2. Do either of the following:

Right-click the selected exhibit or exhibit pages, click Delete Exhibit Page Annotations, and

then click Delete Only Stamps.

On the IMAGE TOOLS tab, click Delete Annotations, and then click Delete Only Stamps.

3. In the confirmation box, click Yes.

The exhibit stamps are deleted.

Related Topics
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Printing Exhibits

Exporting Exhibits, Media Clips, and Playlists

Printing Exhibits
You can print exhibits individually, in groups, or all at once. 

Note that when you print exhibits, any annotations that have been applied to exhibits, including
exhibit stamps, are not printed. To print exhibits with annotations showing, you can export them
using one of the burn-in options, and then print them from an external application. To learn how
to export exhibits and how to configure burn-in options, see: Exporting Exhibits, Media Clips, and
Playlists.

To print exhibits

1. Select the Exhibits navigation bar.

2. Open the folder that contains exhibits you want to print.

3. Do either of the following: 

Select an individual exhibit to print. Next, if the exhibit has more than one page, select the

individual pages you want to print. 

By default, when you select an individual exhibit, only the first page is selected to print. If the
exhibit has multiple pages and you want to print any others in addition to the first page, you
will need to select those pages in the page list. 

You can select multiple pages in the list by pressing Ctrl and clicking pages, or by pressing
Shift and clicking a range of pages.

Select more than one exhibit to print. 

When you select multiple exhibits, all pages of each selected exhibit are automatically selected
and will print.

You can select multiple exhibits in the list by pressing Ctrl and clicking exhibits, or by pressing
Shift and clicking a range of exhibits.
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4. Do any of the following: 

Press Ctrl+Shift+P. 

Right-click any item that you selected to print and then click Print.

On the HOME tab, in the Share group, click Print.

5. Select print options as needed and then click Print.

Related Topics

Annotation Tools

Exporting Exhibits, Media Clips, and Playlists

Rotate Pages and Documents

You can rotate individual pages of one exhibit or all the pages of one or more exhibits at a time.

To rotate an individual page

1. Select the page you want to rotate.

2. Do either of the following:

On the IMAGE TOOLS tab, click Rotate Right or Rotate Left.
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Press Ctrl+Period to rotate right, or Ctrl+Comma to rotate left.

Use this procedure to change a single page. If you want to rotate all pages of one or more
exhibits at a time, use the procedure described below.

To rotate multiple exhibits at a time

1. Select the exhibits that you want to rotate.

2. Right-click one of the exhibits that you selected.

3. Click Rotate Pages and then click either Rotate All Pages Left or Rotate All Pages Right.

For each selected exhibit, all of the pages will be rotated.

Annotation Layers

Tear Out Tool

Annotating in Real Time

Save as New Page

You can save a copy of an exhibit page or image and then apply annotations to the copy without
changing the original exhibit. 

Note the following:
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Annotations that were already applied to the original are also copied over.  

The name of the new page is the same as the existing page but it has 3 digits appended. For

example, if a new page were to be created from an page named ExhibitE, the new page would be
named ExhibitE.001.

Page copies are ignored by wizards for renaming, renumbering, and applying Bates numbers.

Page copies cannot be exported.

The page count for the exhibit, as shown in the Pages column of the exhibit list, will reflect the

number of original pages. Pages that were saved as new are not counted.

To save a page as a new page

1. On the HOME tab, click the Exhibits navigation bar. 

2. Select the exhibit that has the page you want to make a copy of. 

3. Right-click the page and then click Save as New. 

The new page is created in the page list above the original page. The new page will have a 3
digit number appended to the end of its name. For example, if you were to Save As New an
exhibit page with the name, P001234, the new page will be named P001234.001.

Related Topics

Annotation Tools

Annotation Layers

Setting Zoom and Page View

Text Clips

Video Stills

Adding and Removing Items

Screen Captures

You can create screen captures of the exhibit display window. Screen captures are saved as new
exhibits. 

By default, screen captures are added to Exhibits > Images > Captures folder. From there, they can
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be added to presentations, moved, renamed, or deleted.

 

Sanction puts screen captures in Exhibit > Images > Captures

To create screen captures

1. On the IMAGE TOOLS tab, click the Exhibits navigation bar. 

2. Select the exhibit page you want to make a screen capture of. 

3. In the Tools group, click Crop Zoom.

4. Select part of the image you want to create a capture of. 

Note that only that part of the page or image that is shown in the exhibit viewer will be
captured. As an alternative to using the Crop Zoom tool, you can use the scroll bars,
magnification slider, and the page layout controls to size and position the window the way you
want the capture to look.

5. Press F7, or on the HOME tab, click Capture.



Exhibits 103

© 2015 LexisNexis. All rights reserved.

6. Type a name for the capture and then click OK. 

The capture is saved to the Exhibits > Images > Captures folder.

Related Topics

Annotation Tools

Annotation Layers

Setting Zoom and Page View

Text Clips

Video Stills

Adding and Removing Items

Tear Out Tool

As you run a presentation, you can use the tear out tool to temporarily magnify one or more
rectangular areas of an exhibit. Tear outs can be created from within the presentation window by
accessing the annotation tools gallery, or they may be created in the main program window from the
IMAGE TOOLS tab.

Note the following considerations when using the tear out tool:

Tear outs can be annotated, resized, and moved.

You can make multiple tear outs on an exhibit. 

Tear outs do not persist after moving to another item or closing the presentation. 

Tear outs display on Layer 1, which means that until you close a tear out, it remains visible

regardless whether other layers are set to be visible or not.

Dragging the mouse across a tear out creates a highlighted area on Layer 1 of the exhibit page.

The highlight persists on Layer 1 after the tear out is closed. For more information on layers,
see: Annotation Layers.

Unlike other image tools, tear outs created in the main window are not reflected in the

presentation window. For this reason, tear outs created in the main window are typically used for
practice purposes only.

To access the tear out tool, open the tools gallery of the presentation window. Or click the IMAGE

TOOLS tab in the Exhibits area of the main window.

To create a tear out from the presentation window

1. In the presentation window open the exhibit you want to use the tear out tool on. 

2. Do either of the following:

Press Ctrl+O.

Click the annotation tools button located on the lower right corner of the item window, and

then select the Tear Out tool.
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Tear Out tool in the presentation window

3. To create the tear out, drag across the exhibit. When you release the mouse, the tear out
displays on top of the presentation.

To create a tear out from the IMAGE TOOLS tab

1. Select the exhibit you want to use the tear out tool on. 

2. Select the IMAGE TOOLS tab.

3. Either press Ctrl+O, or click Tear Out.

4. Select Standard or Ripped Edge, depending on the effect you want.

5. Drag across the exhibit. When you release the mouse, the tear out displays on top of the
presentation.

To close the tear out, double-click it.

To manipulate a tear out

1. Select the tear out tool and then drag across the exhibit. 
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2.  A tear out window opens.

To do this
to the tear
out:

Perform these steps:

Resize

1. Move the mouse to the lower right or lower left corner of the tear out until
the cursor changes to the resize cursor. 

2. Drag to resize the tear out.

Move

1. Move the mouse to the top of the tear out window.

A gray bar appears at the top of the tear out area.

2. Drag to move the tear out.

Close

Do either of the following:

Double-click anywhere in the tear out.

Move the mouse to the upper right corner of the tear out and then click the

close window icon when it becomes visible.

Draw a
highlight

Once the tear out is open, drag across it to create a highlight. 

To access other annotation tools when a Tear Out is open

1. Right-click the tear out area on the screen.

The annotation gallery appears. 

2. Apply annotations as needed.

To set the default size, position, and border of tear outs

You can set the defaults for tear outs from the main window or from within the presentation
window.
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1. Do either of the following: 

From the main window, on the FILE tab, click Options.

From the presentation window, click .

The Sanction Options dialog box opens.

2. Click Exhibits.

3. In the Tear Out Options area, adjust the default tear out size, position, and shape as needed. 

Size can be set to between 50 to 100 percent. 

Position can be set to the top, center, or bottom of the screen.

Shape can be set to default, which is a smooth edge, or to a ripped edge.

4. Click OK.

Related Topics

Annotation Layers

Annotating in Real Time

Text Clips

A text clip is a screen capture of a transcript segment, which is saved as an exhibit. 

The text clip can be added to a presentation to focus attention to an excerpt of a transcript. You
create a text clip from either an open transcript in the Transcript area or from within the presentation
window. 

Sanction saves text clips to the Exhibits > Images > Text Clips folder. 

Sanction puts text clips in Exhibit > Images > Text Clips
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Text Clip options

When you create a text clip, you can select whether to include the name of the transcript and/or
the page and line range from where the text clip was drawn. These values can be edited as
needed. 

The screen shot below shows how the transcript title and page/line values look when included in
the text clip.

A name and range can be added to the text clip

To create a text clip

1. Do one of the following: 

Click the Transcripts navigation bar and then select a transcript.

Open the transcript in the presentation window.

2. Select the text you want to use as a clip. 

3. Do either of the following:

Press Ctrl+Shift+X.

Right-click the selected text and then click New Text Clip. Alternatively, if you are working in

the Transcripts area, on the New group, click Text Clip.

4. In the Create New Exhibit dialog, type a name for the clip.

5. If you want, you can add a name and range to the top of the text clip. 
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Select Include Name to display the text as the top line of the text clip. You can edit this field

as necessary. By default, the value for this field is the file name of the document. 

Select Include Range to display the page and line number range as the top line of the text

clip. 

Select both fields if you want the name followed by the range above the clip text.

6. Click OK.

The clip is visible within the Exhibits folder, under the Images folder in Text Clips. 

To view text clips

1. Click the Exhibits navigation bar.

2. Expand the Exhibits tree and then expand Images.

3. Select the Text Clips folder. 

Text clips in the page list view

4. Select the clip you want to view.

The text clip is visible in the exhibit viewer.

Related Topics

Annotation Tools

Annotation Layers

Screen Captures

Video Stills

Adding and Removing Items

Video Stills

A video still is a single frame from a video, which is saved as an exhibit. 

You create a video still from an open video in the Media area or from a video open in the
presentation window. 

When you create a video still, Sanction puts it into the Exhibits > Images > Video Stills folder. 
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Sanction puts video stills in Exhibit > Images > Video Stills

To create a video still

1. Do one of the following:

In the main program window, click the Media navigation bar, and then select a video.

In the presentation window, open a video in the presentation.

2. Use the playback controls to move to the place in the video that you want to create a still of.

3. On the media player, click the Video Still button or press Ctrl+Shift+V.

The video still button on the media player

4. In the Create New Exhibit dialog, type a name for the still and then click OK. 

The new video still is visible within the Exhibits folder, under the Images folder in Video Stills. 
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To view video stills

1. Click the Exhibits navigation bar.

2. Expand the Exhibits tree and then expand Images. 

3. Select the Video Stills folder. 

The video still is visible in the page preview window.

Related Topics

Annotation Tools

Annotation Layers

Screen Captures

Adding and Removing Items

Wizards for Renaming, Renumbering, and Bates
Numbering
Introduction

Sanction provides wizards for renaming and renumbering exhibits, and for applying Bates numbers to
them. These wizards are accessible from the Info area of the FILE tab. They are also available as a
final, optional step when running the the exhibit import wizard. 

Options for each wizard

Wizard Options
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Alphanumeric 

prefix and/or

suffix

Number format

for zero
padding

Start
number

Period
separator

Comma
separator

Dash
separator

Number the
first page

Renaming*       

Renumbering

Exhibit numbers or trial
numbers.

     

Bates numbering     

* For multi-page exhibits, you can iterate the naming scheme on individual pages. You can also
set the exhibit name as the name of the first page.

To renumber exhibits and exhibit pages

1. On the FILE tab, click Info, and then click Rename & Renumber.

2. Click Rename Exhibits. 

The Welcome dialog box  for the Exhibit Renaming Wizard opens.

3. Click Next.

4. Select the folder that contains the exhibits you want to rename.

5. Move exhibits to the right column using the following options:

Select individual items and then click Add Selected.

Click Add All to select all items in the current folder.

If necessary, remove items from the right column, by selecting items there, and then clicking 

Remove Selected or Remove All.   

6. Repeat the selection process on exhibits in other folders as needed until all the exhibits you
want to rename are listed in the right column.

7. Click Next

The Order Exhibits dialog box opens. The position of exhibits in the list reflects the order of the
numerical sequence of the exhibit name.

8. Select items and then click Move Up or Move Down as needed to reposition exhibits in the
order you want, and then click Next.

The Naming Options dialog box  opens.

9. Select options as needed and then click Next. For more information on available options, see
the table at the start of this topic.
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10.Review your selections. When ready, click Next.

The renaming process runs. When it finishes, a completion dialog box opens.

11.Click Close.

To update exhibit numbers or trial numbers

1. On the FILE tab, click Info, and then click Rename & Renumber.

2. Select Exhibit Numbering. 

The Welcome dialog box  for the Exhibit Renaming Wizard opens.

3. Click Next.

4. Select the folder that contains the exhibits you want to rename.

5. Move exhibits to the right column using the following options:

Select individual items and then click Add Selected.

Click Add All to select all items in the current folder.

If necessary, remove items from the right column, by selecting items there, and then clicking 

Remove Selected or Remove All.   

6. Repeat the selection process on exhibits in other folders as needed until all the exhibits you
want to renumber are listed in the right column.

7. Click Next

The Select Exhibit Numbers Field dialog box opens. 

8. Select Exhibit Numbers or Trial Numbers, depending on the property you want to change,
and then click Next. 

9. Select items and then click Move Up or Move Down as needed to reposition exhibits in the
order you want, and then click Next.

The Exhibit Numbering Options dialog box  opens.

10.Select options as needed and then click Next. For more information on available options, see
the table at the start of this topic.

11.Review your selections. When ready. click Next.

The renumbering process runs. When it finishes, a completion dialog box opens.

12.Click Close.

To apply Bates numbering

1. On the FILE tab, click Info, and then click Rename & Renumber.
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2. Select Bates Numbering. 

The Welcome dialog box  for the Exhibit Renaming Wizard opens.

3. Click Next.

4. Select the folder that contains the exhibits you want to apply Bates numbers to.

5. Move exhibits to the right column using the following options:

Select individual items and then click Add Selected.

Click Add All to select all items in the current folder.

If necessary, remove items from the right column, by selecting items there, and then clicking 

Remove Selected or Remove All.   

6. Repeat the selection process on exhibits in other folders as needed until all the exhibits you
want to apply Bates numbers to are listed in the right column.

7. Click Next

The Order Exhibits dialog box opens. 

8. Select items and then click Move Up or Move Down as needed to reposition exhibits in the
order you want, and then click Next.

The Bates Numbering Options dialog box opens.

9. Select options as needed and then click Next. For more information on available options, see
the table at the start of this topic.

10.Review your selections. When ready, click Next.

11.The renaming process runs. When it finishes, a completion dialog box opens.

12.Click Close.

Related Topics

Importing Exhibits

Editing Item Properties

Zoom and Page View Settings

You can adjust the page view in the exhibit viewer by either zooming in on an image, or by setting
the layout of the page to one of several preset views..

To zoom in or out

1. Select the exhibit page you want to zoom in on.

2. Do one of the following:
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On the IMAGE TOOLS tab, in the Tools group, click Crop Zoom or press Ctrl+M. Then select

the area on the exhibit you want to zoom to. To return to the original view, double click
anywhere within the zoomed region. 

 

On the bottom right of the exhibit viewer screen, move the slider to zoom in or out to zoom

as needed.

If you zoom in, you might need to re-center the image by using the scroll bars of the exhibit
viewer.

To set the view using presets

1. Select the Exhibits navigation bar. 

2. Select the exhibit you want to adjust the view on. 

3. On the bottom right of the exhibit viewer screen, select one of the preset views next to the
slider.

These are the preset view options:

Fit to page. The entire page view is scaled to the viewing window. .

Fit to width. The page view is scaled so that the entire width of the page is visible in the
viewing window. This view can be helpful when you want to more easily read the text of a
letter- or legal-sized document

Fit to height. The page view is scaled so that the entire page can be seen in the viewing
window. For wider documents, this view might require that you scroll left and right to view page
content located toward the left and right margin of the page. 

Actual size. The page view is not scaled. If the exhibit is larger than the viewing window, you
will need to use scroll bars to see any page content outside the viewing window. 

Related Topics

Annotation Layers

Tear Out Tool

Annotating in Real Time
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Media

Importing Media

You can import video and audio files into your case. 

There are two ways to import media. You can either drag and drop folders and files directly into a
folder in the Media area, or you can run the Media Import Wizard, which is available from FILE >
Info > Import or from HOME > Import. 

If you import folders of media items, Sanction creates new folders in the Media tree that mirror those
you import.

To import exhibits by using drag and drop

1. With a case open, click the Media navigation bar.

The Media folders are listed.

2. Drag and drop files or folders into any folder in the Media tree, except Playlists. 

A dialog box confirms the file import by providing a count of the number of files that were
imported and notes if any files could not be imported.  

3. Click Close to finish the import.

To import media by using the import utility

1. Do one of the following:

Press Ctrl+I.

On the FILE tab, click Info, click Import, and then click Media. 

On the HOME tab, click Import. and then click Media. 
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The Media File Import Wizard starts.

2. Click Next. 

The Select Files to Import dialog box opens.
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3. Click Add Files or Add Folder, depending on whether you want to select files individually or by
the folder. 

Option Perform these steps

Add files individually

1. Click Add Files.

2. Browse to the folder that has files you want to add.

3. Select one or more files, and then click Open.

Add a folder with or
without its
subfolders

1. Click Add Folder.

2. Browse to the folder that has files you want to add.

3. Click Select Folder.

4. Add more items or remove items from the list as needed. When your list contains all the files
you want to import, click Next.

The Select Import Destination Folder dialog box opens.
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5. Select a destination folder and then click Next. If necessary, you can click New Folder and then
create a new folder as a destination for the import.

The Ready to Import dialog box opens.



LexisNexis Sanction120

© 2015 LexisNexis. All rights reserved.

6. Review the summary of your import selections. If the file list and destination folder are all right,
then click Next. 

The import proceeds. When completed, the Import Confirmation dialog opens. It provides a
count of the number of transcripts that were imported. Any error that occurred during import is
noted on the Import Confirmation screen. 
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7. Click Close.

The files are added to the case in the folder you selected.

Related Topics

Overview of Importing

Importing Exhibits

Importing Transcripts

Moving Exhibits and Media

Preferred Media Paths 

Adding and Removing Items

Media Clips

You can create a clip from an audio file, video file, or from a video deposition. Once a clip is created, it
is ready to be added to a playlist or it can be added to a presentation directly. To create a clip, you
use the media player and the clip creator.  These tools become available whenever you select a
video, audio item, synchronized transcript, or clip. 

You can also create clips by selecting lines from a video depositions. For more information, see: 
Synchronized Transcripts.
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Media player with Clip Creator

Clips may be made from video transcripts by importing a clip list. A clip list is a text file that you can
create with Notepad or other plain text editor. The list identifies page and line numbers of the
transcript where you want clips to start and end.

To create a media clip from an audio or video file

1. On the HOME tab, click the Media navigation bar.

2. Select an audio or video file from the media list.
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The media player opens in the preview window.

3. Use the play/pause button, and the slider on the media player to move to where you want your
clip to start.

4. Click Set Clip Start. 

5. Use the play button and the slider on the media player to move to where you want your clip to
end.

6. Click Set Clip End.

If necessary you can precisely edit the start and stop times. For more information, see the next
procedure in this topic.

7. Type a name for the clip, add a description, then click Save.
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The clip is now listed in the media clip list for that media item. From here, the clip may be added
to presentations directly or combined with other clips into playlists. For more information on
adding clips to a presentations, see: Add and Remove Items. For more information on creating
playlists, see: Playlists. You can also return to the clip anytime to adjust its timing, rename it, or
delete it.

To precisely edit the timing of a clip

You can precisely adjust the start and stop time of clips. This can be done either at the time you
are creating clips or later, after they are saved.

1. Select the clip you want to edit. 

2. Cue playback to begin a few seconds before the desired start time or end time.

3. Refine the start and stop times by using the tools described in the following table.

4. When you have cued playback to exactly where you want the clip to start or end, click the Set
Clip Start or Set Clip End button.

5. Click Save. 

To precisely cue the player, use the following options in the Clip Creator, individually or in
combination:  

Tools

Click  to start playing the clip again from the start.

Click  to start playing the clip 3 seconds before the end of the clip.

Depending on whether you want to change the start or the end time, perform the following
mouse operations on the start time field or the end time  field: 
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Click the left mouse button on the field to move the time back 1 second, or press Shift+left-

click to move the time back 1/10th of a second. 

Click the right mouse button on the field to advance the time 1 second, or press Shift+right-

click to advance the start time 1/10th of a second. 

Note that these actions cause playback to immediately resume.

To preview a media clip

1. On the HOME tab, click the Media navigation bar. 

2. Select the media item that has the clip you want to preview. 

3. In the clip list, click the clip you want preview.

4. In the media player, click the play button. 

To rename or edit the properties of a clip

1. On the HOME tab, click the Media navigation bar.  

2. Select the media item that has the clip you want to rename or edit. 

3. In the clip list, do one of the following:

To do this: Perform these steps

Rename the clip

1. Do either of the following: 

On the ribbon, in the Actions group, click Rename.

Right-click the clip, and then click Rename.

2. Type the new name, and then press Enter.

Rename the clip or edit its
1. Do either of the following: 
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properties

On the ribbon, in the Actions group, click Edit.

Right-click the clip, and then click Edit.

The clip properties dialog box opens. 

2. Edit properties as necessary then click OK.

To add clips to a playlist or presentation

1. On the HOME tab, click the Media navigation bar. 

2. Select the media item that has the clip you want to add to a presentation or playlist. 

3. In the clip list, select the clips you want to add to a presentation or playlist. 

4. Select from among the following options:

To do this: Follow these steps:

Add clips to a
presentation

Do one of the following:

On the ribbon in the Add to group, click Presentation, and then select the

presentation you want to add the clips to. 

Right-click the clip selection, click Add to Presentation, and then select

the presentation you want to add the clips to. 

Add clips to a
playlist

Do one of the following:

On the ribbon in the Add to group, click Playlist, and then select the

playlist you want to add the clips to. 

Right-click the selected clips, click Add to Playlist, and then select the

playlist you want to add the clips to. 

Related Topics

Importing Media

Media Playback

Adding and Removing Items

Playlists

You can use playlists to present multiple media items and clips back-to-back without any pause
between them.

The process of creating playlists

At a high level, the process of creating playlists involves the following steps:

1. Create media clips from media items. For more information on creating media clips, see: Media
Clips.

2. Create the playlist. There are several ways to create playlists. These ways are described in
other procedures in this topic.

3. Add the media clips to the playlist. 
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4. Edit the playlist as needed. This can mean doing any of the following:

Change the sequence in which clips are played.

Remove or add clips.

Change the name of the playlist.

Add or edit the playlist description.  

These actions are described in this topic.

5. Add the playlist to a presentation. For more information on adding playlists and other items to a
presentation, see: Adding and Removing Items.  

To create a playlist via Playlist folder

1. Click the Media navigation bar.

2. Click the Playlist folder. 

3. On the HOME tab, in the New group, click New Playlist.

4. Type a name for the playlist and then click OK.

The new playlist is created in the Playlist folder. 

To create a playlist via clip selection

1. Click the Media navigation bar.
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2. Browse to the media item that has clips you want to start a new playlist from. 

3. Select the clips you want to create a playlist from. 

You can use Ctrl+click or Shift+click to select multiple clips

4. Do one of the following:

Right-click a selected clip, click Add to Playlist, and then click New Playlist.

On the HOME tab, in the Add To group, click Playlist. and then click New Playlist.

5. Type a name for the playlist and then click OK. 

The new playlist is created. Click the Playlist folder to see your new playlist. 

To add clips to a playlist

1. Click the Media navigation bar. 
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2. Browse through the media folders to select the media item that has the clip you want to add to
the playlist. For information about creating media clips, see: Media Clips.

3. In the clip list area of the workspace, select the clip you want to add to the playlist.

4. Do one of the following:

Right-click the selected clips, click Add to Playlist, and then select an existing playlist or create a

new one.

On the HOME tab, in the Add To group, click Playlist, and then select an existing playlist or click

New Playlist to add the clip to a new playlist.
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The clip is added to the playlist.

To change the presentation sequence of clips

1. Select the Media navigation bar.

2. Select the Playlist bar and then select the playlist you want to change the clips for.

3. Select the clip that you want to change the sequence for and then do one of the following:

On the HOME tab, in the Actions group, click Move Up or Move Down, depending on where

you want to move the clip.

Right-click the clip, and then click Move Up or Move Down, depending on where you want to

move the clip. 

To rename or add a comment to a playlist
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1. Click the Media navigation bar.

2. Click the Playlist folder.

3. Follow steps as indicated in the following table:

To accomplish this: Do this:

Rename the playlist Right-click the playlist, click Rename, type the new name, and then
press Enter.

Rename or add a
comment to the playlist

Right-click the playlist, click Edit, type a new name, and/or add a
comment, and then click OK. 

To remove media clips from a playlist

1. Click the Media navigation bar. 

2. Click the Playlist folder.
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3. Select the playlist you want to remove the clip from. 

4. In the clip list, select the clips you want to remove from the playlist.

5. Do one of the following:

On the HOME tab, in the Actions group, click Remove Item.

Right-click the clip, and then click Remove Item. 

The clip is removed from the playlist.

To delete a playlist
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1. Select the Media navigation bar.

2. Select the Playlist button. 

3. Select the playlist you want to delete. 

4. Do one of the following:

Press Ctrl+D.

On the HOME tab, in the Actions group, click Delete.

Right-click the playlist and then click Delete. 

The playlist is deleted and removed from presentations. However, the clips which comprised the
playlist are not deleted and can still be used in other playlists.

To add a playlist to a presentation from the main program window

1. Select the Media navigation bar.

2. Select the Playlist button. 

3. Select the playlist you want to add to a presentation. 

4. Do one of the following:

On the HOME tab, in the Add To group, click Presentation and then select an existing

presentation or click New Presentation to create a new one.

Right-click the playlist, click Add to Presentation, and then select an existing presentation or

click New Presentation to create a new one.

On the HOME tab, in the Present group, click Show Item. The playlist opens in the

presentation window and is added to the current presentation.  

To add a playlist to a presentation from the presentation window

From the presentation window, type the name of the playlist and then press Enter.

The playlist opens in the presentation window and is added to the end of the presentation.

Related Topics

Media Clips

Adding and Removing Items
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Preferred Media Paths

A preferred media path is a folder location on your computer that is registered in a Sanction case.
Sanction uses these paths to find media, the video for synchronized transcripts, and playlists. 

By default, the Media folder within the case folder on the computer's file system is registered as a
path. 

When you import media, a new preferred media path is added to your case, which points to source
folder for the media. Also, during the import process, you can optionally specify that all subfolders be
added as preferred media paths. 

Sanction will also register a preferred media path to the Transcripts folder if you import a
synchronized transcript to the Transcripts folder. These paths are editable.

Note that merely copying media files to a preferred media path folder does not make them
immediately visible from within the case. For a case to be visible, it must be imported. For more
information on importing media, see: Importing Media.

You can manually add, edit or delete preferred media paths by doing any of the following:

On the FILE tab, click Info, and then click Media Paths.

In the main program window, at the top of the folder list, right-click the case name and then

click Preferred Media Paths.

When importing transcripts, as of the last steps in the transcript import wizard, you can open

the preferred media paths dialog box. You would normally use this method if the video for a
synchronized transcript was kept in a folder other than the Transcripts folder.   

Note the following considerations:

If you move media to a folder location that is not registered as a preferred media path, you must

add a preferred media path to the new media location. For more information on moving cases
and media see: Moving Cases and Media Files.

When you try to play media that Sanction is unable to find, error conditions occur. For more

information, see: Support Notes.

If you receive this error message: Media File Not Found, it means that a preferred media path
has not been established to the media you are attempting to play. This condition can be the
result of importing a synchronized transcript without also having established a media path to the
video portion of the transcript. 

To rectify this situation, you can do any of the following:

Use the Media Import Wizard to re-import the audio or video. For more information, see: 

Importing Media.

Copy the media file to the Media folder in the case folder on the Windows file system. You

can determine the folder location on the Windows file system. To do so, on the FILE tab,
click Info. The folder path is provided in the Case Directory field.

Manually establish a preferred media path to the media file, which is described in this topic.

For more information, see: Support Notes.

To manually add, edit, or delete a preferred media path

1. Open the case that you want to change the path for. 
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2. Do either of the following:

Select the FILE tab, click Case Media Paths, and then click Add. 

Select the HOME tab, in the task column heading, right-click the case name, and then click

Preferred Media Paths.

 

3. Select an option. 

Option Steps

Add a new path.

Do one of the following:

Type the path and then click OK. 

Click Browse, select the updated folder, click Select Folder, and

then click OK.

Edit an existing path.

Select the path you want to edit, and then do one of the following:

Type the new path over the existing one and then click OK.

Click Browse, select the updated folder, click Select Folder, and

then click OK.

Note that when adding a new path or editing an existing one, if you want Sanction to
automatically include all folders under a selected path, then click Include Subfolders.

Delete a path. Select the path and then click Delete.

4. Click OK. 

You are returned to the Case Properties dialog box.
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5. Click OK.

To change the order of preferred media paths

1. Open the case. 

2. Do either of the following:

Select the FILE tab, click Case Media Paths, and then click Add. 

Select the HOME tab, in the task column heading, right-click the case name, and then click

Preferred Media Paths.

o

3. Select a media path and then click Move Up or Move Down as needed to reposition it in the
list. Repeat this step with any other media path that you want to reposition.

4. Click OK. 

To add a path when importing transcripts

1. Start the process of importing transcripts into your case by doing either of the following:

On the FILE tab, in the Info area, click Import, and then click Transcripts.

On the HOME tab, click Import, and then click Transcripts.

2. Proceed with running the wizard to import transcripts, until the Import Confirmation step. 

3. In the Import Confirmation dialog box, click Select Media Paths.

4. Click Add, and then click the folder that has media for your case in it. 

Select Include Subfolders if you want Sanction to find media in any folders within the folder
you selected.
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5. Click OK.                                                                  

Related Topics

Importing Media

Support Notes

Copy Video Files to the Case Media Folder

You can use Sanction to copy all the video files for your case to the Media folder for the case. Media
files are copied from each preferred media path registered for the case. Copying all the media files to
the local media folder can help to ensure that if you move your case, the video files will be moved
along with the case.

To copy video files to the case media folder

1. On the FILE tab, in the Info area, click Copy Video Files.

 The Copy Video Files wizard starts.

2. Click Next.

3. Navigate to videos you want to copy to the case media folder for your case and then do the
following:

Click Add All to copy all the files in the selected folder.

Click Add Selected to copy just the selected videos.

Click Remove Selected to remove a video from the selection list.

Click Remove All to clear the selection list.

4. When the selection list has the files you want to move, click Next.

5. In the Ready page of the wizard, verify the list of files you want to copy and the folder path to
the Media folder for the case. 

6. Click Next.

7.  In the confirmation screen, click Close.              

Related Topics

Importing Media

Support Notes

Video Stills

A video still is a single frame from a video, which is saved as an exhibit. 

You create a video still from an open video in the Media area or from a video open in the
presentation window. 
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When you create a video still, Sanction puts it into the Exhibits > Images > Video Stills folder. 

Sanction puts video stills in Exhibit > Images > Video Stills

To create a video still

1. Do one of the following:

In the main program window, click the Media navigation bar, and then select a video.

In the presentation window, open a video in the presentation.

2. Use the playback controls to move to the place in the video that you want to create a still of.

3. On the media player, click the Video Still button or press Ctrl+Shift+V.

The video still button on the media player

4. In the Create New Exhibit dialog, type a name for the still and then click OK. 
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The new video still is visible within the Exhibits folder, under the Images folder in Video Stills. 

To view video stills

1. Click the Exhibits navigation bar.

2. Expand the Exhibits tree and then expand Images. 

3. Select the Video Stills folder. 

The video still is visible in the page preview window.

Related Topics

Annotation Tools

Annotation Layers

Screen Captures

Adding and Removing Items
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Transcripts

Importing Transcripts

You can import transcripts, including synchronized transcripts into your case. 

There are two ways to import transcripts into your case. You can either drag and drop transcripts
directly into the transcripts list, or you can run the Transcripts Import Wizard, which is available from 
FILE > Info > Import or from HOME > Import.

To import exhibits by using drag and drop

1. With a case open, click the Transcripts navigation bar.

2. Drag and drop transcripts individually or by the folder to the list area just above the navigation
bars.  

A dialog box confirms the file import by providing a count of the number of transcripts that
were imported and notes if any were skipped. 

3. Click Close.

To import transcripts by using the Import Wizard

1. With a case open, do one of the following:

Press Ctrl+I.

On the FILE tab, click Info, click Import, and then click Transcripts. 
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On the HOME tab, click Import. and then click Transcripts.

The Transcript File Import Wizard opens.

2. Click Next.

The Select Transcript Files to Import dialog box opens. 

3. Click Add Files and then browse to the folder where the transcripts are located. Select the
transcripts you want to import and then click Open. The transcripts you selected are listed in
the dialog box. Repeat this step as needed to select more transcripts.

4. Click Next.

The Ready to Import dialog box opens.

5. Click Next.

The selected transcripts are imported and the Import Confirmation dialog opens displaying a
count of imported transcripts. 

6.  Do one of the following: 

For this condition: Perform these steps:

None of the transcripts
you imported were
synchronized transcripts.

Click Close. 

One or more of the
transcripts you imported
are synchronized
transcripts.

AND 

The media files for the
synchronized transcripts
have not been added to
the Media folder for the
case in the Windows file
system.

1.Click Select Media Paths. The Case Media Paths dialog box
opens.

2.Review the list of paths. 

3.Add paths as needed to make sure each media file can be
reached along a path.

o If a path already exists to a folder that is positioned higher in

the file system hierarchy than the folder that contains
transcript media, then click Edit, click Include Subfolders, and
then click OK.

4.When finished adding paths, click OK to finish working in the
Case Media Paths dialog box.

5.Click Close to complete the Transcript File Import Wizard.

7. If any of the transcripts you imported are synchronized transcripts click the Select Media
Paths button and then do the following:
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For each synchronized transcript listed, make sure there is a media path. 

If any path that is missing, click Add, click Browse and then select the folder that contains the

media. If you want to select a folder at a higher level, such as the root of an external drive you
can click Include Subfolders. 

If importing synchronized transcripts, at the end of the import wizard, click Select Media Paths and add paths to
the media files.

         

Related Topics

Overview of Importing

Importing Exhibits

Importing Media

Preferred Media Paths

Adding and Removing Items

Integration with LexisNexis TextMap

Synchronized Transcripts

You can work with synchronized transcripts in the following ways to enrich presentations:

Add them directly into presentations. There are several methods for accomplishing this. A

common way to add synchronized transcripts is described in Adding and Removing Items. Other
methods, more typically used to add synchronized transcripts during presentations. are described
in Using the Show Item Command, and in Controlling Item Presentation. 
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Create media clips with synchronized text playback. 

Add media clips taken from synchronized transcripts to playlists and presentations. 

Hide or show the synchronized text in presentations. If you choose to show synchronized text,

you can specify its position on screen, font characteristics, the number of lines to display, and
highlighting options. You can also modify the timing, name, and other properties of the clips you
create from transcripts.

Create text clips and video stills. For more information, see: Text Clips and Video Stills.

To create a media clip from a synchronized transcript

This procedure describes how to create an individual media clip by using the Clip Creator utility.
However, it is also possible to create multiple clips at a time by importing a clip list file. For more
information on creating and importing clip list files, see: Clip Lists for Synchronized Transcripts.

1. On the HOME tab, click the Transcripts navigation bar. 

2. Select the synchronized transcript that you want to create a clip from.

The media player and clip creator open next to the transcript.

3. Specify the start and stop times of the clip by using one of the following methods:

Method Steps

By selecting
transcript text

1. Select the lines of transcript that you want in the clip. 

2. Right-click the selection and then click New Media Clip.  

The media player starts playing the video at the start of the selection and
pauses playback when the end of the selection is reached. The Start and
Stop times are also populated accordingly. 

3. Type a name for your clip. Note that the description field is auto-populated
with the page and line numbers of the clip. 

4. Edit the description as necessary and then click Save.

By typing the
page and line
numbers (Quick
Clip)

1. Type the page and line range of the clip into the Quick Clip field and then
press Enter.
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The Start- and End time of the page and line range are populated in their
respective fields. The Description field is populated with the Page and line
range. 

2. If necessary, you can more precisly adjust the timing of your clip. For
more information see the procedure To precisely edit the timing of a
clip in this topic.

3. Type a name for the clip, and optionally, edit the clip description, and then
click Save.

You can use any of the following formats to indicate the page/line range for
the clip:

Pg.Ln+Pg.Ln
Pg:Ln+Pn:Ln
Pg.Ln-Pg.Ln
Pg:Ln-Pg:Ln

For example, 4:14-4:17 starts the clip on page 4, line 14 and ends it on
page 4, line 17.

By using the
play button and
the media slider 

1. Use the play button and media slider to move to the start of the clip and
then click Set Clip Start.
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2. Use the play button and media slider to move to the end point of the clip
and then click Set Clip End.

3. In the Name field, type a name for the clip and then click Save.

The clip is visible in the media clip list.

To add clips from a synchronized transcript to a playlist or presentation

1. On the HOME tab, click the Transcripts navigation bar. 

2. Select the transcript that has the clip you want to add to a presentation or playlist. 

3. In the clip list, select the clips you want to add to a presentation or playlist. 

4. Select from among the following options:

To do this: Follow these steps:

Add clips to a presentation

Do one of the following:

On the ribbon in the Add to group, click Presentation, and then

select the presentation you want to add the clips to. 

Right-click the clip selection, click Add to Presentation, and then

select the presentation you want to add the clips to. 

Add clips to a playlist

Do one of the following:

On the ribbon in the Add to group, select Playlist, and then select

the playlist you want to add the clips to. 

Right-click the selected clips, click Add to Playlist, and then select

the playlist you want to add the clips to. 

To preview a synchronized transcript clip

1. On the HOME tab, click the Transcripts navigation bar. 
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2. Select the transcript that has the clip you want to preview. 

3. In the clip list, do one of the following:

Double-click the clip.

Select the clip you want preview and then click the play button on the media player.

The clip video plays in the media viewer. In the transcript window, the current transcript line is
indicated by a red box around the line.

To rename or edit the properties of a clip

1. On the HOME tab, click the Transcripts navigation bar.  

2. Select the synchronized transcript that has the clip you want to rename or edit. 

3. In the clip list, follow steps that go with what you want to do:

Action Steps

Rename the clip 1. Do either of the following: 

On the ribbon, in the Actions group, click Rename.

Right-click the clip, and then click Rename.

2. Type the new name, and then press Enter.

Rename the clip or edit
its properties

1. Do either of the following: 

On the ribbon, in the Actions group, click Edit.

Right-click the clip, and then click Edit.

The clip properties dialog box opens. 

2. Edit properties as necessary then click OK.

To precisely edit the timing of a clip

As you create a new clip or edit an existing clip, can precisely adjust the start or end of the clip. 

The method of accomplishing this is to begin playing the clip at a position slightly ahead of the
desired start time or end time. Then, as playback proceeds, you click the Set Clip Start or Set Clip
End at the exact position where you want the clip to start or end. 

To precisely cue the player, use the following options in the Clip Creator, individually or in
combination:  

Options

 Click  to start playing the clip again from the start.
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 Click the  to start playing the clip 3 seconds before the end of the clip.

Depending on whether you want to change the start or the end time, perform the following
mouse operations on the start time field or the end time  field: 

Click the left mouse button on the field to move the time back 1 second, or press Shift+click

to move the time back 1/10th of a second. 

Click the right mouse button on the field to advance the time 1 second, or press Shift+right

click to advance the start time 1/10th of a second. 

Note that these actions cause playback to immediately resume.

As playback resumes, when the player gets to the precise moment where you want the clip to
start or end, click Set Clip Start or click Set Clip End.

To set presentation options for synchronized transcripts

1. Open the Sanction Options dialog box using either of the following methods:

To
configure
options
from this
window:

Follow these steps:

Main program
window

On the FILE tab, click Options.

Presentation
window

In the presentation window, select the presentation options icon.

 

2. Click Presentations. and then scroll down to the Synchronized Text section of the dialog
box.
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3. Configure options as needed. These are described as follows:

Main option Description

Synchronized
Text

Select this option to show synchronized text in the item window. Text
appears below the media player. 

Lines to Display controls the number of lines of text that are shown.

The number can range from 1 to 10.

Synchronized Line specifies the line that holds the currently playing

text.

Font Settings specify the font, size and color of the text.

Background Color specifies the background of the text field that

displays the synchronized text.

Highlight Color specifies the color that is applied to the currently

playing line of transcript.

Synchronized
Text As Overlay

Select this option to overlay synchronized text  on top of the media player.

Font Settings specify the font, size and color of the text.
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Hide
Synchronized
Text

Select this option to hide synchronized text so that it does not appear at
all.

4. Click OK.

Related Topics

Text Clips

Media Clips

Media Playback

Adding and Removing Items

Clip Lists for Synchronized Transcripts

If you need to create many individual clips from the same synchronized transcript, using a clip list can
save you time when compared to typing each clip individually into the Quick Clip field of the media
player. 

A clip list is a plain text file that contains a list of the clips that you want to create from a
synchronized transcript. You can create a clip list by using any text editor, such as Notepad. After you
create a clip list file, you can use Sanction to import it, which will create the clips. 

To create the clip list file

1. Read over the transcript to identify the page and line numbers where you want each clip to
start and end.

2. Open a plain text editor, such as Notepad.

3. For each clip you want to create, type the page and line number for the start of the clip
followed by the page and line number for the end of the clip, using the following format:

Pg:Ln-Pg:Ln

For example, the following would create 2 individual clips: 

4:14-4:17
5:2-6:20

The first clip would start on page 4, line 14 and end on page 4, line 17. The second clip
would start on page 5, line 2, and end on page 6, line 20.

4. After each page and line range add a hard return. 

5. Save the file.

6. Use Sanction to import the file. The import process is described in the next procedure of this
topic.

Any of following formats may be used to designate ranges for individual clips:
Pg.Ln+Pg.Ln
Pg:Ln+Pn:Ln
Pg.Ln-Pg.Ln
Pg:Ln-Pg:Ln

To import the clip list
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1. On the HOME tab, click the Transcripts navigation bar.

2. Click the synchronized transcript that you want to create the clips for. 

Synchronized transcripts are marked with a film frame icon

3. On the HOME tab, click Import, and then click Clip List.

The Welcome to the Clip List Import Wizard dialog box opens.

1. Click Next.

The Select Clip List File to Import dialog box opens.

2. Click Add File.

3. Navigate to the clip list file, select it, and then click Open.

The clips are listed in the Select Clip List to Import dialog box.

4. Click Next.

The Import Confirmation dialog box opens.  

5. Click Close.

The clips are created for the synchronized transcript and ready to use.

Related Topics

Overview of Importing

Importing Exhibits

Importing Transcripts

Moving Exhibits and Media

Preferred Media Paths 

Adding and Removing Items
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Text Clips

A text clip is an exhibit captured from a segment of transcript segment. The text clip are typically
added to a presentation to focus attention upon a transcript excerpt. 

You create a text clip from either an open transcript in the Transcript area or from within the
presentation window. Sanction saves text clips to the Exhibits > Images > Text Clips folder. 

Text clips made from transcripts are added to the Text Clips folder

To create a text clip

1. Do one of the following: 

Click the Transcripts navigation bar and then select a transcript.

Open the transcript in the presentation window.

2. Select the text you want to use as a clip. 

3. Do one of the following: 

Press Ctrl+Shift+X.

On the HOME tab, in the New group, click Text Clip.

Right-click the selected text and then click New Text Clip. 

4. Alternatively, if you are working in the Transcripts area, on the New group, you can click Text
Clip.

5. In the Create New Exhibit dialog, type a name for the text clip.

6. If you want, you can add a name and range to the top of the text clip. 

Select Include Name to display the text as the top line of the text clip. You can edit this field

as necessary. By default, the value for this field is the file name of the document. 

Select Include Range to display the page and line number range as the top line of the text

clip. 

Select both fields if you want the name to appears as the top line, followed by the range, and

then the clip text.
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A name and range can be added to the top of the text clip

7. Click OK.

The clip is visible within the Exhibits folder, under the Images folder in Text Clips. 

To view text clips

1. Click the Exhibits navigation bar.

2. Expand the Exhibits tree and then expand Images.

3. Select the Text Clips folder. 

Any video stills created for the case are visible in the page list view.

4. Select the clip you want to view.

The text clip is visible in the page preview window.

Related Topics

Screen Captures

Video Stills

Adding and Removing Items
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Set Transcript Viewer Options

You can set the font, font size, and highlight color for transcript text. On synchronized transcripts,
you can also show or hide the date stamp. 

To set transcript viewer options

You can set the defaults for the transcript viewer from the main window or from within the
presentation window.

1. Do either of the following: 

From the main window, on the FILE tab, click Options.

From the presentation window, click .

The Sanction Options dialog box opens.

2. Click Transcripts.

3. Adjust transcript display settings as needed. 

Synchronized transcripts can show or hide a date stamp.

The highlight color for synchronized transcripts can also change. 

Transcript text font, size, and color can also be set.

4. Click OK.

For more information, see: Set Presentation Options.

Related Topics

Screen Captures

Video Stills

Adding and Removing Items
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Search

Searching for Case Items

You can find items in your case by running searches based on the following item properties:

Item name

Exhibit number

Trial number

Bates number

Description

Admit date or date range

Transcript date or date range

You can also the text of a transcript. For more information, see: Searching Transcript Text.

To find items by item properties

1. On the HOME tab, click Find Items.

 

Dialog box for searching case item properties 

2. Construct your search by property or by date using options as needed.

These options are listed as follows:
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Search type Description of options

Search by
property

Available properties: 

Name

Exhibit Number

Trial Number

Bates Number

Description

Operators: 

Contains

Equals

Search by
date

Available date fields:

Admit date

Transcript date

Date types: 

Specific date

On or before

On or after

3. Click OK. 

The search results are listed. 

4. Do either of the following: 

Double click the item to open it. 

Click New Search, which opens the search dialog box again.
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Related Topics

Editing Item Properties

Wizards for Renaming, Renumbering, and Bates Numbering

Searching Transcript Text

Searching Transcript Text

You can search for a word in a transcript that is open in either the main program window or the
presentation window.

To search a transcript

1. Do either of the following depending on whether you are working in the main program window
or the  presentation window.

2. In the main program window, on the HOME tab, click the Transcripts navigation bar, and then
slect the transcript you want to search.

3. In the presentation window, open the transcript you want to search. 

4. Click the search box, type a search term, and then press Enter.

5. Use the navigation buttons to move among search hits. 

Related Topics

Text Clips

Synchronized Transcripts

Searching for Case Items
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Creating and Managing Presentations

Create a Presentation

You can create a new presentation either:

HOME > Presentations navigation bar > New Presentation.

Right-click a single-page exhibit, image, or page > New Presentation. 

Right-click a media item or clip > New Presentation.

A presentation name cannot contain any of the following characters:  / \ : * < > |

To create a presentation from the Presentations navigation bar

1. Click the Presentations navigation bar.

2. On the HOME tab, click New Presentation or press Shift+Ctrl+N.

3. Type a new name for the presentation and then click OK.   

The new presentation appears in the presentation list.

To create a presentation by right-clicking an item

1. Click either the Exhibits navigation bar, the Media navigation bar, or the Transcripts
navigation bar.

2. Right-click any of the following kinds of items that you want to create a presentation from:

Exhibit page or image

Media item

Media clip
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Transcript

3. On the right-click context menu, click Add To Presentation, and then click New
Presentation. 

4. Type a new name for the presentation and then click OK.   

The new presentation appears in the presentation list. 

To rename or delete a presentation

1. On the HOME tab the Presentations navigation bar.

2. Select the presentation you want to rename or delete. 

To do this: Perform these steps:

Rename the
presentation

On the HOME tab, in the Actions group, click Rename, or right-click the

presentation and then click Rename. Type a new name for the presentation
and then click OK.   

Delete the
presentation

On the HOME tab, in the Actions group, click Delete, or right-click the

presentation and then click Delete. Click Yes in the confirmation dialog box.
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Related Topics

Adding and Removing Items

Add or Remove Items

You can add items to presentations from the main program window or from the presentation
window. This topic focuses on how to add items from the main program window. To learn how to
add items while presenting, see: Adding Items During the Presentation. 

To add items to presentations from the main program window

1. Click the navigation bar that corresponds to the type of item you want to add to your
presentation. 

To add this type of item: Select this navigation bar:

An exhibit page

Image

Screen capture

Text clip of a transcript

Still image from a video

Time line image

Exhibits

Audio

Video

Media clip

Playlist

Media

Plain text transcript

Synchronized transcript

Transcripts
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2. Select the item that you want to add.

3. Do one of the following: 

On the HOME tab, in the Add To group, click Presentation, and then click the presentation

that you want to add the item to.

Right-click the item, click Add to Presentation, and then click the presentation that you

want to add the item to.

4. Optionally, to verify that the item was added to the presentation, click the Presentations
navigation bar and then select the presentation.  

Items that were added appear in the presentation item list. After you add items, you can
change their sequence in which they will appear in the presentation. For more information, see: 
Changing Item Presentation Sequence.

To remove items from a presentation

1. On the HOME tab, click the Presentations navigation bar.

2. In the presentation list, click the presentation you want to remove items from. 

3. In the item list, select items you want to remove and then do one of the following:

Press Ctrl+Alt+R.

On the HOME tab, in the Actions group, click Remove Item.

Right-click the items and then click Remove Item. 

The selected items are removed from the presentation. 
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Never use the Delete command to remove an item from a presentation. Attempting to do
so will delete the entire presentation.

Related Topics

Annotating in Real Time

Using the Show Item Command

Controlling Item Presentation

Displaying Multiple Item Windows

Find the Source Location of Items

After you add an item to a presentation, you can easily locate the source item in the case. This can
help, for example, if you want to update an exhibitafter you have added it. Or it can also help if you
want to create a new media clip from a media item you already added to a presentation.

To locate item sources

1. Click the Presentation navigation bar, and then select the presentation that you want to work
with.

 

2. In the item list of the presentation, right-click the item that you want to find the source location
for, and then click Find Source Location.

Select the item > right-click > Find Source Location

Sanction opens the folder for the item with the item highlighted.

Related Topics

Annotating in Real Time
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Add or Replace Exhibit Pages

Media Clips

Displaying Multiple Item Windows

Change Item Presentation Sequence

By default, the order in which individual items are added to a presentation determines the order in
which they are presented. However, after items are added, you can change their order of
presentation. 

The current presentation order can be determined by looking at the position of items in the item list
for the presentation. The top item will be presented first, with all others following. For example, in the
following screen capture, when the Example Items presentation is started, Form will be the first item
in queue, followed by Brochure, and then Letter.

To change item presentation sequence

1. Click the Presentations navigation bar.

2. Select the presentation you want to change the sequence of item presentation. 

3. Select items you want to change the presentation sequence for and then do one of the
following:

On the HOME tab, in the Actions group, click Move Up or Move Down, depending on where

you want to place items. 

Right-click and then click Move Up or Move Down, depending on where you want to place the

items. 

The selected items are removed from the presentation. 

     Related Topics

Annotating in Real Time

Using the Show Item Command

Controlling Item Presentation

Displaying Multiple Item Windows

Set Presentation Options

There are many options in the presentation window that you can set to suit your needs as a
presenter. The options that you select will apply to all presentations across all cases and will remain in
effect until you change them. 

The rest of this topic lists the presentation options that you can configure, as well as the procedures
for configuring them from the FILE tab or from the presentation window.
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Presentation options available in the Sanction Options dialog box from the presentation window or from FILE tab >
Options > Presentations

Presentation window settings

Setting Available
Options

Description

Shown On Primary

Display2

If set to Primary, presentations open on the primary monitor.
Otherwise, presentations open on a second display, such as a
connected second monitor or projection device.

Show Border No border

Show borders

Show borders
on Selected

Controls whether a border appears around individual display
panels in the presentation window. A border can help to
improve the visibility of some items.

Search By Name

Exhibit number

Trial exhibit
number

Bates number

Determines the item property for blind typing. The default
property is Name.

Show Search
Text Box

Enabled or
unchecked

If enabled, the search bar is always visible in the presentation
task bar. Otherwise it is only visible when searching. 

Load first item Enabled or
unchecked

If enabled, when you launch a presentation, the first item in the
presentation is shown automatically. Otherwise the
presentation opens with a black screen. 
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Autohide the
Task Bar when
not in use.

Enabled or
unchecked

If enabled, the presentation task bar slides out of view during
the presentation and slides into view when you move the
mouse to the bottom of the presentation window. If
unchecked, the presentation task bar remains visible.

Show Item
Name on Task
Bar

Enabled or
unchecked

If enabled, shows the item name on the presentation taskbar.
Otherwise, the item names do not appear.

Start media
playback
immediately
when a media
item is
selected.

Enabled or
unchecked

If enabled, when a media item is selected it starts playing
immediately. Otherwise the media does not start until you click
the play button or press Ctrl+P.

Synchronized
Text

Synchronized
Text

Synchronized
Text As
Overlay

Hide
Synchronized
Text

If set to Synchronized Text, synchronized transcript text scrolls
below the player window. Options for this include:

Number of lines: 1 -10. This is the number of lines of text

that appear onscreen.

Synchronized line: 1 - 3. This is the line number that is in

sync with the video.

Lines to highlight: 1 - 3. The number of lines that are

highlighted.

Font, font size, color. Font settings of the synchronized text.

Background- and highlight color. Color of the text

background and of the highlight.

If set to Synchronized Text As Overlay, synchronized transcript
text appears as overlay on the lower part of the video window.
Options for this include: 

Font, font size, and color of overlaid text.

Background color and opacity. 

If set to Hide Synchronized Text, synchronized text does not
appear onscreen.

For information on setting transcript font, font size, and font color in the presentation window
and in the main program window, see: Set Transcript Viewer Options.

To access the presentation settings

You can configure presentation settings from the main window or from within the presentation
window.

To
configure
options
from this
window:

Follow these steps:

Main program
window

1. On the FILE tab, click Options.
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The Sanction Options dialog box opens.

2. Select Presentations. 

3. Configure options as needed and then click OK. 

Presentation
window 1. In the presentation window, click  the presentation options icon. 

The Sanction Options dialog box opens.

2. Configure presentation options as needed and then click OK.  

Related Topics

Presenting on a Second Display

Displaying Multiple Item Windows

Annotating in Real Time

Media Playback
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Running Presentations

Annotating in Real Time

While running a presentation, you can annotate exhibits from the main program window if Sanction is
set to run on 2 displays.  Alternatively, you can annotate by using annotation tools available in the
presentation window. 

For information on Annotation Tools, see: Annotation Tools.

To apply annotations from the main program window

1. Set the presentation to open on Display 2, add an exhibit to a presentation, and show the
exhibit in the presentation.

For information on using a second display see: Presenting on a Second Display.

For information on adding items to a presentation, see: Add and Remove Items. 

For information on showing an exhibit in a presentation, see: Using the Show Item

Command. See also: Controlling Item Presentation.

2. In the main program window, on the HOME tab, click the Exhibits navigation bar. 

3. Click the exhibit page that is currently being presented. 

4. On the IMAGE TOOLS tab, select an annotation tool and apply your annotation.  For more
information, see: Annotation Tools.

As you apply annotations, they are reflected in real time in the presentation window.

You can setup annotations ahead of time and then have them appear on cue in the
presentation window by using annotation layers. For more information, see: Annotation Layers.

To apply annotations from within the presentation window

1. Open the exhibit you want to annotate in the presentation window. 

2. In the item presentation window, click the annotation tool icon.

The annotation tools gallery opens. 
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Annotation tools gallery in the presentation window 

3. Select an annotation tool and then apply it to the exhibit window as needed. 

For descriptions of available annotation tools, including how to set certain defaults, see: 
Annotation Tools. 

To add annotation layers from the presentation window

You can apply your annotations in layers in the main program window or in the presentation
window. This procedure describes how to add annotations in layers while working in the
presentation window. For information on working with annotation layers while working in the main
program window, see: Annotation Layers.

1. In the presentation window, open the exhibit you want to work with. 

When you click the exhibit, Layer 1 is active by default.

2. Add annotations that you want to appear automatically each time the exhibit is opened. 

During a presentation, when you first open an exhibit, Layer 1 is selected and visible. All other
layers are hidden. 

3. In the item window, click the tools icon.
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4. Select Layers.

 

By default, Layer 1 is selected and visible

5. Select the radio button to the left of 2. 

The Layers tool box closes. Layer 2 is visible and active in the presentation window. Any
annotations added now are applied to Layer 2.

6. Add annotations to Layer 2 as needed. 

7. If you want to add more layers, click the tools icon again. Then repeat the steps to select an
annotation layer and add annotations to it.

To show or hide annotation layers from the presentation window

This procedure assumes that the exhibit you are presenting already has annotations applied to it
on separate layers. 

The presentation window provides keyboard shortcuts to toggle whether layers are shown or
not. For more information, see: Keyboard Shortcuts.

1. In the presentation window, open the exhibit you want to work with.

2. In the item window, click the tools icon.

3. Select Layers.
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By default, Layer 1 is selected.

4. Select the icon to the right of the layer number you want to become visible. Note that Layer 1
cannot be hidden.

The universal no icon  means that the layer is hidden. An eye icon  means that the layer is

currently visible. In the following graphic, layers 1 and 2 are visible. 

Layer 1 is selected, and layer 2 is visible as well as layer 1.

Related Topics

Setting Presentation Options

Using the Show Item Command

Controlling Item Presentation

Displaying Multiple Item Windows

Keyboard Shortcuts

Displaying Items

From within the presentation window, you can select items for presentation in the following ways:

Move between items in a linear sequence like a slide show.

Pick items from a list. 

Type the item name, exhibit number, trial exhibit number, or Bates number. Using this method,

you can type into a visible search box, or blind type the search. Either way, if the item that you
type was not already included the presentation, it is added to the end of the presentation. 
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To display items in a sequence

In the far right side of the presentation toolbar, click . 

The presentation advances to the next item. 

Note that at the start of the presentation, until the forward button is clicked, the previous
button is inactive. When the last item in the presentation is reached, the forward button
becomes inactive. 

By default, when the presentation window is set to a display mode of Side By Side, 2 Across, or
4 Quadrants, the next item and previous item buttons focus on the most recently opened item
window. However, you can configure the buttons to operate on whichever item window you
want. 

For more information, see: Displaying Multiple Item Windows.

To pick items from a list

1. In the presentation window, click the item selector button.

2. Select Go to Item.  

3. Select the item you want to display.

4. The item appears in the presentation window.

To display items by typing 

In the presentation window, do either of the following:

Type the item name, exhibit number, trial exhibit number, or Bates number, depending on

which item property the search box is configured to accept and then press Enter.

1. In the presentation window, click the item selector button.

2. Select Show Item.

The search box opens in the presentation tool bar.
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3. Type the item name, exhibit number, trial exhibit number, or Bates number, depending on which
item property the search box is configured to accept, and then press Enter. 

The item opens in the presentation window. If the item was not already a part of the current
presentation, it is added to the end of the presentation.

If a matching item is not found, a warning icon appears on the presentation task bar, but the
state of the presentation window does not change otherwise.

To resolve this, here are some things to try:

Check the spelling of the item. 

Check the search properties to determine which field the search box is set to accept. For

example, the search will probably yield an error if the search box is set to accept the item
name and you type a Bates number. To access search box options, see: Setting
Presentation Options.

To configure blind typing

Blind typing is enabled by default. The following procedures tells you how to make sure that blind
typing is enabled and that the search function is set to the item property you want to search by.

With blind typing, all you do to display an item is type its name, exhibit number, trial exhibit
number, or Bates number, depending on which item property the search is configured to accept. 

1. To enable blind typing, from the presentation window, click the Presentation Options button. 

2. In the Sanction Options dialog box, uncheck Show Search Text Box. 

3. Verify whether the property type that is selected in the Search By list is the one that you want
to search by.
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4. Click OK. 

5. In the presentation window, type the item name, exhibit number, trial exhibit number, or Bates
number, depending on which item property the search box is configured to accept.

6. Press Enter.

The matching item is displayed in the presentation window. If the item is not already part of the
presentation, it is added to the end.

If a matching item is not found, a warning icon  appears on the presentation task bar, and
the state of the presentation window does not change.

To resolve this, here are some things to try:

Check the spelling of the item. 

Return to the Sanction Options dialog box and then verify the property type is set to the

one you want to search by. 

Related Topics
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Annotating in Real Time

Using the Show Item Command

Displaying Multiple Item Windows

Displaying Multiple Item Windows

You can split the presentation window into multiple item windows to simultaneously present up to 4
different items at a time. The setting that determines this number is called the View Mode. 

View Modes

You can set the View Mode to: 

Full Screen

Side By Side

3 Across 

4 Quadrants. 

Where can the View Mode be set?

You can change the View Mode either from the main program window (HOME > Presentations >
View Mode button group, which is active only when a presentation is showing. Or you can change the
View Mode from within the presentation window itself. 

View Mode can be set in HOME > Presentations > View Mode button group. 

View Mode can also be set in the Presentation Window

How the View Mode works

The View Mode determines the behavior of the presentation window in these ways:

View Mode sets the upward limit to the number of item windows that can open. This term, 

upward limit is used here because the presentation screen always opens in Full Screen. If a
different View Mode (Side By Side, 3 Across, or 4 Quadrant) is selected, the presentation window
only divides into Side By Side, 3 Across, etc., each time you click the next item button. However,
you can override this behavior by unlocking the Display Mode, which is discussed later in this
topic.

As more item windows open, View Mode locks the action of the next and previous item buttons

onto the most-recently opened item window. For example, if you set the View Mode to 3 Across,
once the third item window is opened, the next and previous item buttons only act upon the third
item window. 

It is possible to override this behavior and move between items in a different item window by
unlocking the Display Mode. This is discussed next in this topic.
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Overriding the View Mode by unlocking the Display Mode

When the View Mode is set to Side By Side, 3 Across, or 4 Quadrants, you can temporarily suspend
new item windows from opening before you have reached the maximum allowed for that View Mode
setting. You can also page through items in whichever item window is open, not just the most
recently opened item window.

The setting you use to make these changes during your presentation is called the Display Mode. 

How the Display Mode works

The Display Mode can be set to locked or unlocked. By default, it is set to locked. Unlocking the
Display Mode has the immediate effect of preventing new item windows from opening. Unlocking the
Display Mode also allows you to change the focus of the next and previous item buttons, so that
clicking these buttons will effect whichever item window you select. 

Where can the Display Mode be set?

Like the View Mode, you can control the Display Mode either from the main program window (HOME
> Presentations > Display Mode button group) or from within the presentation window itself.

To split the screen from the main program window

1. Open the presentation on a second display.

2. In the main program window, on the HOME tab, click the Presentations navigation bar.

In the View Mode button group, by default Full Screen mode is selected. 

3. Click the View Mode that you want your presentation to display.

4. Switch to the presentation window.

5. Click . 

Each time  is clicked, a new item window opens, populated with the next item in the
presentation.

To split the screen from within the presentation window

1. Open your presentation.

2. In the presentation window, click the View Mode button.
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3. Click the View Mode that you want your presentation to display.

4. Click . 

Each time  is clicked, a new item window opens, populated with the next item in the
presentation.

To unlock Display Mode from the main program window

1. Open a presentation on a second display. 

2. In the main program window, on the HOME tab, click the Presentations navigation bar.

In the View Mode button group, by default Full Screen mode is selected. 

The Display Mode is locked

3. Set the View Mode to either Side By Side, 3 Across, or 4 Quadrant.
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4. Switch to the presentation window.

5. Click  until you have the number of item windows you want open.

6. Switch to the main program window.

7. Click Display Mode.

The Display Mode is unlocked

8. Return to the presentation window.

9. Click any item window.

10. On the presentation toolbar, click the next or previous item button. 

The next or previous item is displayed in the selected item window.

11.Click any other item window.

12. Click the next or previous item button. 

The next or previous item is displayed in the selected item window.If needed, return to the main
program window and then click Display Mode again to lock it.

To set the Display Mode from the presentation window

1. Open a presentation. 

2. In the presentation window, click the View Mode button.
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3. Click the View Mode that you want your presentation to display.

4. Click  until you have the number of item window open that you want.

Each time  is clicked, a new item window opens, populated with the next item in the
presentation. Note that in the screen capture above, the Display Mode is locked.

5. Click the Display Mode button to unlock the Display Mode.

Display Mode is unlocked

6. Click any item window.

7. Click the next or previous item button. 

The next or previous item, relative to the item window, opens in the selected item window. 

Example: showing 3 items simultaneously

These steps illustrate how to present 3 items simultaneously. The screen captures in the procedure
are provided as examples. 

1. Open a new presentation that has 3 or more items in it. 

2. In the presentation window, click .

The first item in the presentation opens. 
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3. In the presentation window, click the View Mode button.

4. Select 3 Across. 

The maximum number of item windows that can be open at one time will be 3

5. Click .

The presentation window is now divided into 2 item windows. The newly opened item window
shows the second item in the presentation. 

6. Click  again.
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The presentation window is now divided into 3 item windows, the maximum that can be
opened with the 3 Across view mode. This third item window shows the third item in the
presentation. 

Each time you click  again, the next item in the presentation will load in the third item
window. For example, in the screen shot above, if the next item arrow is clicked again, the
timeline image will be replaced by the next item in the presentation. The item windows showing
the synchronized transcript and the letter will not change.

To reassign the next and previous item buttons to a different item window

1. In the presentation window, set the View Mode to Side By Side, 3 Across, or 4 Quadrants. 

2. Repeatedly click  to open multiple item windows until the maximum number of item
windows is open. 

3. Click the Display Mode button so that it is unlocked.

Display Mode is locked Display mode is unlocked.

4. Select the item window you want to use the next and previous item buttons on.

5. Click  and  to move between items in the selected item window.

If the Display Mode is unlocked, it is possible for the same item in the presentation to be
shown in two different item windows at the same time. 

In this situation, clicking   will effect the window that first opened the shared item.
regardless of which item window is selected.

To suspend the maximum number of item windows that can open

1. Click the Display Mode button so that it is unlocked.
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Display Mode is locked Display mode is unlocked.

The maximum number of item windows that may be opened is set to the current number of
item windows open. 

Using book paging

You can flip though the items in your presentation like flipping through the pages of a book. This
can be helpful when presenting the pages of a deposition of other multi-page print documents.

1. Open the presentation you want to flip through.

2. Press Ctrl+J.

The first item in the presentation is displayed.

3. Press Ctrl+J.

The presentation window changes to side-by-side view mode. The first item is in the left ttem
window, the second in the right. 

4. Press Ctrl+J.

The presentation continues to flip forward, page by page. 

Related Topics

Annotating in Real Time

Showing Items

Controlling Item Presentation

Displaying Multiple Item Windows

Media Playback

Media playback controls are available within the presentation window when media is loaded. The
controls allow you to start, pause, return to the start, and go to the end of the media. In addition,
you can control the volume or mute the playback.
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Media playback controls

While the media is loaded in the presentation window, you can save a video frame in real time as
a video still. Sanction saves the video still as an exhibit. When saved as an exhibit, the video still
can annotated as needed and added to presentations. For more information on creating video
stills, see: Video Stills.

To control playback

1. With the media, clip, or playlist open in the presentation window. 

2. Control playback using the following options:

To do this: Click these buttons:

Start playback of the current clip.

Skip forward to the next clip. The clip starts playing.

Skip to the previous clip. The clips starts playing.

Cue to the start of the next clip without starting
playback. The player screen is black.

 then 

Cue to the start of the previous clip without starting
playback. The player screen is black.  then 

Stop playback and return the play head to the first
frame of the current clip.

Skip several seconds forward.

Click and hold:

 Skip several seconds backward.

Click and hold:
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If you reach the end of the playlist, playback stops and the playing position returns to the
beginning of the first clip in the playlist. The player screen goes black.

To adjust the volume or to mute audio

1. Select the Volume/Mute button on the media player. 

2. Do either of the following:

To increase or decrease the volume, move the slider.

To toggle the audio on or off, click the Mute/unmute button.

You can tell if the audio is muted by examining the Mute/unmute button.

Audio is on

Audio is muted

Related Topics

Setting Presentation Options

Annotating in Real Time

Using the Show Item Command

Controlling Item Presentation

Displaying Multiple Item Windows

Opening and Closing Presentations

You can open presentations from the main program window or from the presentation window.  This
topic covers basic procedures for opening and closing presentations. 
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For information on an alternative way to open presentations, see: Using the Show Item Command. 

To open a presentation from the main program window

1. Click the Presentations navigation bar.

2. Select the presentation you want to open.

3. On the HOME tab, in the Present group, click Presentation.

The presentation window opens with the selected presentation ready to start. The presentation
window opens with no item displaying. 

You can configure the presentation window to load the first item when the presentation is
started instead of opening to a blank screen. For more information, see: Setting Presentation
Options. 

4. Click  or press Ctrl+Right Arrow to show the first item. 

To open a presentation from the presentation window

1. On the presentation tool bar, click the presentation selection button.
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2. Select the presentation you want to open. 

To close a presentation

Do one of the following:

Click the presentation selection button,  located at the left corner of the presentation taskbar,

and then click Exit.

If an image is loaded in the presentation window, then right-click a section of the presentation

window to the left or right of the image and then click Exit.

If media is loaded in the presentation window, then right-click anywhere in the presentation



Running Presentations 189

© 2015 LexisNexis. All rights reserved.

window and then click Exit.

Press Shift+Esc.

In the presentation window, you can press Esc to cause the presentation window to go blank.
The presentation will remain open in the presentation window but no item will be showing.

Related Topics

Annotating in Real Time

Using the Show Item Command

Controlling Item Presentation

Displaying Multiple Item Windows

Presenting on a Second Display

If your computer is configured to use the extended desktop feature in Windows, you can show your
presentation on the second display, such as a monitor, flat screen TV, or projector. 

On Windows 7 computers, to extend display to a second monitor, press the Windows logo key+P,
and then click Extend. Another way to access the setting is by opening the Display control panel in
Windows (Start > Control Panel > Display > Connect to a Projector). 

To select between displays

1. Make sure extended desktop is enabled on your computer.

2. Click the VIEW tab.

3. Select either Primary or Display2 from the list.

When Primary is selected, presentations open in the main monitor. 

When Display2 is selected, presentations open in the second display.  

If Display2 is not listed in, here are some things to try:

Make sure the second monitor is powered on.

Verify the physical connection to the second monitor. 

Check the Windows display setting or video card application setting. The option to extend

the desktop to the second monitor should be enabled. On Windows 7 computers, to
extend display to a second monitor, press the Windows logo key+P, and then click
Extend. Another way to access the setting is by opening the Display control panel in
Windows (Start > Control Panel > Display > Connect to a Projector). 

If you enabled extended desktop after opening the case, try closing the case and then

opening it again.
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Related Topics

Annotating in Real Time

Using the Show Item Command

Controlling Item Presentation

Displaying Multiple Item Windows

Using the Show Item Command

You can immediately show in the presentation window any exhibit page, media item, media clip,
playlist, or transcript, even if the item has not been previously added to a presentation and even if
the presentation window is not open. 

To accomplish this, you run the Show Item command.

HOME > Present > Show Item 

When you run the Show Item command, the following conditions apply:

The presentation that is selected in the presentation list will open. If the presentation window

already has a different presentation showing, the selected presentation will take its place.

Show Item opens the item in the currently selected presentation

The item you used the Show Item command on will be added to the end of the presentation. 

If the item you show was already a part of the presentation, a second instance of the item will be

added to the end of the presentation, except when the item is selected from a the item list of a
presentation.

To show an exhibit, media item, or transcript from the main program window

1. Select the item that you want to show. 

2. Do either of the following: 

Press Ctrl+S.

On the HOME tab, in the Present group, click Show Item. 
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The item opens in the presentation window. If a presentation is not already open, the item
opens in the presentation that is selected in the presentation list. 

To show an item selected from a presentation item list

1. Select the Presentations navigation bar.

2. Select the presentation that has the item that you want to show.

3. In the item list for the presentation, select the item you want to show.

4. From the main program window, do either of the following: 

Press Ctrl+S.

On the HOME tab, in the Present group, click Show Item. 

The item opens in the presentation window.

      

Related Topics

Annotating in Real Time

Controlling Item Presentation

Displaying Multiple Item Windows
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Exporting

Exporting Exhibits, Media Clips, and Playlists

If you want to work with exhibits, media clips, or playlists outside of Sanction, you can export these
kinds of items. These options are available:

When you export exhibits, you can burn in the annotations so that they appear on the exhibit

images that are exported. 

When exporting exhibits, you can also choose whether to export them using the same format

they were in when they were imported, or you can export exhibits as PDF files. 

You also export duration list reports. For more information, see: Duration List Reports.

To export exhibits

1. Do one of the following:

On the FILE tab, in the Info area, and then click Export. 

On the HOME tab, click Export.

2. Click Exhibits.

The Welcome dialog box opens.

3. Click Next.

4. Open the folder that has the exhibits that you want to export.

5. Do either of the following, depending on what you want to export. 

Click Add All to add all the listed items.

Select individual files or folders and then click Add Selected. 

After adding items, you can remove them as needed from the queue. To remove one or
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more items, CTRL+click or SHIFT+click items and then click Remove Selected. To
remove all items, click Remove All.

Items that are ready to be exported and are listed in the right panel of the dialog box.

6. Click Next. 

The Select... dialog box opens.

7. Select options as follows:

Destination. Select the default, which is to the Documents folder for the currently logged in

Windows user, or click Browse and then select a different folder.

Burn-in options. These options control whether annotations that have been applied to exhibits

are saved to the page images on exported files. 

o All Layers. Saves all the annotations found on all layers to page images. 

o Layer 1 Only. Saves all exhibit stamps plus any the annotations found on layer 1 to page

images.

o No Burn-In. Prevents annotations and exhibit stamps from being saved on the image files.

This is the default option.

Export to native or PDF. This option is available in the section marked, "How would you like

to export your exhibits?"

o Convert all exhibits to PDF. Each exhibit in the export set is exported as a separate PDF

file.

o Keep original file type(s) on export. Each exhibit is exported using the file format it had

when imported. 

8. Click Next.
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9. In the Ready to Export dialog box, review your selections and then click Next.

 The export proceeds, and then the Export Confirmation dialog box opens. 

10.Click Close to finish the wizard.

To export media clips

1. Do one of the following:

On the FILE tab, click Info, and then click Export. 

Select the HOME tab and then click Export.

1. To export exhibits, click Exhibits, to export media clips, click Media Clips.

The Welcome dialog box opens.

2. Click Next.

3. Do either of the following, depending on what you want to export. 

Click Add All to add all the listed items.

Select individual files or folders and then click Add Selected. 

Items that are ready to be exported and are listed in the right panel of the dialog box.

4. Click Next. 

The Select Destination Location dialog box opens.
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5. Accept the default export path or click Browse to select a different folder. When ready, click
Next.

6. In the Ready to Export dialog box. click Next.

The Export Confirmation dialog box opens. 

7. Click Close.

To export playlists

1. On the HOME tab, in the Share group, click Export.

2. Click Playlists.

The export wizard starts.

3. Click Next.

4. Do either of the following, depending on what you want to export. 

Click Add All to add all the listed items.

Select individual files or folders and then click Add Selected. 

Items that will be exported now appear in the right panel of the dialog box.

5. Click Next. 

6. Accept the default export path or click Browse and then select a different folder.

7. Click Next and then click Next again to complete the export.

8. Click Close.

Related Topics

Annotation Tools
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Media Clips

Playlists

Duration List Reports
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Reporting

Duration List Reports

A duration list report totals the running time of individual clips and playlists that you select. Optionally,
you can create reports that list the clips, playlists, or presentations in your case. Reports may be
formatted in Rich Text Format (RTF) or plain text. 

You can choose from among several fields to include in your report: 

Media Clip Name

Description

Page and Line Range

Transcript Text

Total Duration

Start and End Times

Title

Duration

Media file Name

To export duration list reports

1. Do one of the following:

On the FILE tab, in the Info area, click Export, and then click Duration List Report.

On the HOME tab, in the Share group, click Export, and then click Duration List Report.

The Duration List Report Export Wizard starts.

2. Click Next.

The Select Media Clips and/or Playlists dialog box opens.

3. In the drop-down list, select Media, Playlists, or Presentations.  

4. Select clips or playlists from the folders positioned in the dialog box below the drop-down list. 

The clips and playlists that you select are listed in the left panel. Note that if you select a playlist,
all the clips that constitute the playlist are automatically added to the report.

5. To add an individual item listed in the left list panel to the report, select the item and then click 
Add Selection. To add all the items in the left list panel, click Add All. 
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After adding items, you can remove them as needed from the queue. To remove one or more
items, CTRL+click or SHIFT+click items and then click Remove Selected. To remove all
items, click Remove All.

6. Click Next.

The Select the Destination File dialog box opens.

7. Select either RTF for Rich Text Format or TXT for plain text format. 

8. Click Change.

The Select the Destination File dialog box opens.

9. Select the folder where you want to save the report, type a file name for the report, and then
click Save.

10.In the Select the Destination File dialog box, review your selections and then click Next.

The Ready To Export dialog box opens.

11.Review your selections. When ready, click Next.

12.In the Export Confirmation dialog box, click Close.

Related Topics

Annotation Tools

Media Clips

Playlists



Sanction 4.0
User Guide

®

Reference

15



LexisNexis Sanction202

© 2015 LexisNexis. All rights reserved.

Reference

Release Notes

1. Installing Sanction® 4 

2. Uninstalling Sanction 4

3. Trial Period

4. Third Party Libraries

5. Technical Notes

6. Known Issues

++++++++++++++++

1. Installing Sanction®

Minimum System Requirements

 2 GHz or faster 32-bit(x86) or 64-bit(x64) processor.

 2 GB RAM

 Approximately 1 GB of free disk space on the system drive. 

 XGA (1024 x 768) or higher-resolution monitor with 256 colors.

 Microsoft Windows 7® or higher - 32-bit(x86) or 64-bit(x64).

 The Microsoft® Framework version 4.5.1 is required.

 Windows Media Player 12 is highly recommended to support media file playback.

 Microsoft Expression® Encoder 4, Service Pack 2 is required for Media Clip export feature.

Installation

You must be logged on with Administrator rights to install the Sanction application.

Sanction must be installed to a local hard drive and cannot be run from a network share or

server.

Prerequisites will be downloaded and installed if they are not available; an Internet connection is

required.

Microsoft Expression Encoder can optionally be installed. It is required for Media Clip export

feature.

Special Notes

Installing Sanction 4 on a system having a version of Sanction 3.1 or older will not remove the

prior version.  It is recommended that you uninstall versions Sanction 3.1 or earlier versions prior
to running the installation.

Uninstalling Sanction versions 3.1 or older after installing Sanction 4 will require Sanction 4 to be

reinstalled.

2. Uninstalling Sanction

To uninstall Sanction, go to Programs and Features in the Windows Control Panel and select
LexisNexis Sanction from the list.



Reference 203

© 2015 LexisNexis. All rights reserved.

3. Trial Period

Sanction installs as an "unregistered" trial copy.  There is a 30-day grace period to use Sanction. 

Once the grace period expires, Sanction will no longer function.  The unregistered copy of
Sanction works identically to the registered version.

4. Third party libraries utilized in LexisNexis® Sanction®

Some user interface controls Copyright © 2008-2103 Telerik AD. All Rights Reserved.

Apache log4net. Copyright © 2004-2013 The Apache Software Foundation

This product includes software developed at The Apache Software Foundation (http://

www.apache.org/).

5. Known Issues

Known issues Include: 

Preferred Media Paths - In Sanction you can add Preferred Media Paths to a case and Sanction

will search those directories for the media files in the case.  You can optionally configure Sanction
to search the subfolders of Preferred Media Path by selecting the Include Subfolders option.  If this
option is enabled, you must have access to all subfolders. If you do not have access to any of the
subfolders, the search for the media file will fail.

Tear Outs in Presentation Mode - Presentation Mode keyboard shortcuts are not available

when the focus is in a Tear Out window.  When you have a Tear Out window displayed while in
Presentation Mode, for the Presentation Mode keyboard shortcuts to work, you must select the
Presentation screen to give it the focus.

Fast User Switching - Only one instance of the Sanction application can run on a single machine.

 Two or more users cannot simultaneously run Sanction on the same machine.  Close the
Sanction application prior to switching users.

Networks - Working on a case file located on a non-local network computer could cause

corruption of the case backup file. It is highly recommended that you work only in case files held
on your local computer.

Related Topics

Welcome

What's New in Sanction

Keyboard Shortcuts

Download a PDF of Sanction 4 Keyboard Shortcuts.

Keyboard Shortcuts - HOME > Exhibits Area

Group > Button Task Shortcut

New > Import
Import exhibits, media, transcripts,
exhibit load files, and clip lists.

Ctrl+I

New > New
Folder

Create a new folder. Ctrl+Shift+F3

New > Capture
Create a screen capture of the
contents of the exhibit viewer.

F7

http://help.lexisnexis.com/litigation/ac/sanction_docs/Sanction4_KBSC_QRC.pdf
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Actions >
Rename

Rename items and folders. F2

Actions > Update
Exhibit

Add pages to an exhibit or update
existing pages. 

Ctrl+U

Actions > Edit
Edit exhibit or page properties, such
as the name, exhibit number, or
Bates number.

Ctrl+Shift+I

Actions > Move Move the selected exhibit. Ctrl+Shift+F2

Actions > Delete Delete the selected exhibit. Ctrl+D

Actions >
Rename Folder

Rename the selected folder. Ctrl+Shift+F

Actions > Move
Folder

Move the selected folder. Ctrl+Shift+M

Actions > Delete
Folder

Delete the selected folder. (Folder
must be empty.)

Ctrl+Shift+D

Add To >
Presentation

Add the selected page to the existing
presentation of your choice. Or
create a new presentation from a
selected page.

Ctrl+Shift A

Present >
Presentation

Open the presentation window. Ctrl+Shift+F1

Present > Show
Item

Immediately open the selected item
in the presentation window.

Ctrl+S

Share > Export
Export exhibits, clips, playlists, and
duration list reports. 

Ctrl+Shift+E

Share > Print Print exhibits. Ctrl+Shift+P

Search > Find
Items

Search for items by item properties,
such as name, exhibit number, trial
number, Bates number, or
description.

Search for items by admit date or
transcript date. 

Ctrl+F

Shortcut keys - HOME > Media

Group > Button Task Shortcut

New > Import
Import exhibits, media, transcripts,
exhibit load files, and clip lists.

Ctrl+I

New > New
Folder

Create a new folder. Ctrl+Shift+F3

New > Video Still
Create a video still from a frame of
video.

Ctrl+Shift+V

Actions >
Rename

Rename the selected media or clip. F2

Actions > Edit
Edit the properties of the selected
media or clip.

Ctrl+Shift+I
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Actions > Move Move the selected media item. Ctrl+Shift+F2

Actions > Delete Delete the selected media or clip. Ctrl+D

Actions >
Rename Folder

Rename the selected folder. Ctrl+Shift+F

Actions > Move
Folder

Move the selected folder. Ctrl+Shift+M

Actions > Delete
Folder

Delete the selected folder. (Folder
must be empty.)

Ctrl+Shift+D

Actions > Move
Up

Move the selected clip up in the
playlist.

Ctrl+Alt+U

Actions > Move
Down

Move the selected clip down in the
playlist.

Ctrl+Alt+U

Actions >
Remove Item

Remove the selected clip from the
playlist.

Ctrl+Alt+R

Add To >
Presentation

Add the selected media to the
existing presentation of your choice.
Or create a new presentation from a
selected media.

Ctrl+Shift A

Add To > Playlist
Add the selected clip to an existing
playlist. Or create a new playlist from
a selected clip.

Ctrl+Y

Present >
Presentation

Open the presentation window. Ctrl+Shift+F1

Present > Show
Item

Immediately open the selected item
in the presentation window.

Ctrl+S

Share > Export
Export exhibits, clips, playlists, and
duration list reports. 

Ctrl+Shift+E

Share > Print Print exhibits. Ctrl+Shift+P

Search > Find
Items

Search for items by item properties,
such as name, exhibit number, trial
number, Bates number, or
description.

Search for items by admit date or
transcript date. 

Ctrl+F

Keyboard Shortcuts - HOME > Transcripts

Group > Button Task Shortcut

New > Import
Import exhibits, media, transcripts,
exhibit load files, and clip lists.

Ctrl+I

New > Media Clip
Create a new media clip from
selected lines in  a synchronized
transcript.

Ctrl+Alt+M

New > Text Clip
Create an image of the selected
transcript text.

Ctrl+Shift+X

New > Video Still Create a new video still from a frame Ctrl+Shift+V
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in a synchronized transcript.

Actions >
Rename

Rename the selected transcript. F2

Actions > Edit Edit transcript properties. Ctrl+Shift+I

Actions > Delete Delete the selected transcript. Ctrl+D

Add To >
Presentation

Add the selected transcript to the
existing presentation of your choice.
Or create a new presentation from a
selected transcript.

Ctrl+Shift A

Add To > Playlist

Add selected clip (from a
synchronized transcript) to an
existing transcript, or create a new
transcript from the selected clip. 

Ctrl+Y

Present >
Presentation

Open the presentation window. Ctrl+Shift+F1

Present > Show
Item

Immediately open the selected
transcript in the presentation
window.

Ctrl+S

Share > Export
Export exhibits, clips, playlists, and
duration list reports. 

Ctrl+Shift+E

Search > Find
Items

Search for items by item properties,
such as name, exhibit number, trial
number, Bates number, or
description.

Search for items by admit date or
transcript date. 

Ctrl+F

Keyboard Shortcuts - HOME > Presentations

Group > Button Task Shortcut

New > Import
Import exhibits, media,
transcripts, exhibit load files,
and clip lists.

Ctrl+I

New > New
Presentation

Create a new presentation. Ctrl+Shift+N

Actions >
Rename

Rename selected
presentation. 

F2

Actions > Delete Delete selected presentation. Ctrl+D

Actions > Move
Up

Move selected items up in the
presentation.

Ctrl+Alt+U

Actions > Move
Down

Move selected items down in
the presentation. 

Ctrl+Alt+D

Actions >
Remove Item

Remove selected items from
the presentation. 

Ctrl+Alt+R

Add To >
Presentation

Add the currently selected item
to a different presentation, or

Ctrl+Shift+A
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create a new presentation
from a selected item.

Present >
Presentation

Open the selected
presentation.

Ctrl+Shift+F1

Present > Show
Item

Open the selected item in the
presentation window.

Ctrl+S

Share > Export
Export exhibits, clips, playlists,
and duration list reports.

Ctrl+Shift+E

Display Mode

Only active when presentation
window is open.

Allows you to change the

focus of the next item
button and previous item
button to different item
windows when View Mode is
set to Side By Side, 3
Across, or 4 Quadrants.

Prevents new item windows

from opening when View
Mode is set to Side By Side,
3 Across, or 4 Quadrant.

Display Mode
(locked)              

Display Mode
(unlocked)

Ctrl+Shift+T (Toggles on/off)

View Mode

Sets a maximum to the
number of item windows that
can be opened at one time in
the presentation window. 

Only active when presentation
window is open.

Regardless of which View Mode
is selected, when you open a
presentation, the window
opens as a Full Screen.

Full Screen: Ctrl+Shift+Up Arrow

Side By Side: Ctrl+Shift+Left Arrow

3 Across: Ctrl+Shift+Right Arrow

4 Quadrants: Ctrl+Shift+Down Arrow

Keyboard Shortcuts - Presentation window

Action Key combination
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Full Screen view mode F11 

or

Alt+Shift+Up Arrow

Side by Side view mode Alt+Shift+Left Arrow 

3 Across view mode Alt+Shift+Right Arrow

4 Quadrant View  Alt+Shift+Down Arrow 

Rotate image counterclockwise Ctrl+Comma 

Rotate image clockwise Ctrl+Period 

Select Ctrl+Shift+S 

Crop/Zoom Ctrl+M 

Tear out (in presentation window) Ctrl+O 

Pan In the presentation window, there is no
shortcut key for the Pan tool.

In the main program window, Ctrl+Alt
+P activates the Pan tool.

Erase Ctrl+D in the presentation window.

In the main program window, Ctrl+Alt
+S activates Erase tool.

Delete all visible annotations Ctrl+Delete 

In presentation window, this shortcut
deletes all visible annotations.

In main program window, this shortcut
activates the Delete Annotations menu
item.

Highlight Ctrl+H

Arrow Ctrl+W 

Line Ctrl+L

Pen Ctrl+N 

Rectangle Ctrl+G

Ellipse Ctrl+E 

Redaction Ctrl+Shift+R 

Play\Pause media Ctrl+P 

Go to page 1. Press CTRL 
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(when multiple pages from the same exhibit
have been added to a presentation) 

2. Press \ 

3. Type the page number 

4. Press ENTER 

Show previous item Ctrl+Left Arrow

Show next item Ctrl+Right Arrow

Close all other item windows Ctrl+Shift+F4 

Display Mode lock/unlock Ctrl+Shift+T 

Zoom in/out exhibit page (using mouse) Ctrl+Mouse wheel forward or back 

Zoom in exhibit page (using keyboard) Ctrl+Plus

or 

Ctrl+Equals

Zoom out exhibit page (using keyboard) Ctrl+Minus

Next presentation 

Previous presentation

Ctrl+Alt+P 

Shift+Alt+P

Clear presentation window Esc

Close presentation window Shift+Esc 

Close all item windows Shift+F4 

Select next item window Tab

Select previous item window Shift+Tab 

Layer visibility Ctrl+[Layer#] (e.g. 2 - 9) to toggle
on/off

Show next hidden layer 

Hide last visible layer

F12 

Shift+F12

(not available in main program
window)

Capture F7 

Page up and page down through a multi-page
exhibit

Page Up

Page Down 

Page forward like a book Ctrl+J

Keyboard Shortcuts - VIEW tab



LexisNexis Sanction210

© 2015 LexisNexis. All rights reserved.

Group > Button Task Shortcut

Layout > Details View
Change the details view of exhibits
to left, minimized, or right.

Ctrl+Alt+V 

Layout > Details View
Show or minimize navigation
panes. 

Ctrl+Alt+N

Monitors
Show presentations on a second
display, such as an external
monitor or projector. 

Ctrl+Alt+Y 

Keyboard Shortcuts - IMAGE TOOLS tab

Group > Button Task Shortcut

Tools > Select Selection tool. Ctrl+Shift+S

Tools > Crop Crop and zoom. Ctrl+M

Tools > Tear Out
Magnify a selected part of the page and
move the selection around.

Ctrl+O

Tools > Magnifier Drag a magnifier across the exhibit. Ctrl+Alt+G

Tools > Pan
Drag a zoomed page around in the exhibit
viewer window.

Ctrl+Alt+P

Tools > Erase

Erase annotations one at a time.

Note -- in the presentation window, the
shortcut key for Erase is Ctrl+D .

Ctrl+Alt+S

Tools > Delete
Annotations

Delete all of the annotations or exhibit
stamps applied to selected exhibit pages.

IMPORTANT

In presentation window, Ctrl+Delete
immediately deletes all visible annotations.

Ctrl+Delete

Annotations > Highlight Create a transparent rectangle. Ctrl+H

Annotations > Arrow Draw an arrow. Ctrl+W

Annotations > Line Draw a line. Ctrl+L

Annotations > Pen Draw a freehand shape. Ctrl+N

Annotations > Rectangle Create an unfilled ellipse. Ctrl+G

Annotations > Ellipse Create an unfilled rectangle. Ctrl+E

Annotations > Redaction Create a filled rectangle. Ctrl+R

Annotations > Text Type text into the exhibit. Ctrl+Alt+X

Options > Line Size
Set the line thickness for: arrow, line, pen,
rectangle, and ellipse.

Ctrl+Alt+I

Options > Line Color
Set the line color for: arrow, line, pen,
rectangle, and ellipse.

CTRL+Alt+O

Options > Fill Color
Set the fill color for: highlight, redaction, and
text box.

Ctrl+Alt+F
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Layers > 1 - 9

Select a layer; show it if it is hidden.

For more information, see: Annotation
Layers.

Ctrl+[Layer#] 

(e.g. 2 - 9)

Image > Rotate Right Rotate page right. Ctrl+Period

Image > Rotate Left Rotate page left. Ctrl+Comma

Image > Print Print the selected exhibit page. Ctrl+Shift+P

Related Topics

Quick Start Guide

Customizing the Layout

Integration with LexisNexis Case Analysis Products

Beginning with Sanction 3.6, you can receive case materials directly from LexisNexis CaseMap® case
analysis software, LexisNexis TextMap® transcript management software, and TimeMap® timeline
graphing software. 

Product Integration with Sanction

CaseMap version
10.1 or higher

Sends linked documents as exhibits to Sanction.

In Sanction, these are received into the Exhibit > Images > From CaseMap
folder.

TextMap 7.2 or
higher

Sends text-only transcripts along with any exhibits that were linked to the
transcript in TextMap.

Sends synchronized transcripts along with linked exhibits, plus annotations
sent as media clips.

TimeMap version
5.1 or higher

Sends timeline visuals to Sanction. In Sanction, these are received into the 
Exhibit > Images > Timelines folder.

Setting up integration with TextMap, TimeMap, or CaseMap

To setup integration you can follow this general process: 

1. In Sanction, open the case you want to use. 

2. Switch to TextMap, TimeMap, or CaseMap, and then open the source case.

3. Follow the steps to send items to Sanction as outlined in the in the CaseMap, TimeMap, or
TextMap Answer Center.

Links to the Answer Centers for these products are available from the Help menus of each
respectively, or browse the LexisNexis Answer Center portal. 

Considerations for TextMap users

Consider the following facts when receiving items from TextMap: 

TextMap names the clips it creates in Sanction based on an acronym of the words of the

transcript name followed by the starting page and line numbers of the clip start.  For example, a
clip that starts on page 4, line 24 of a transcript called Deposition of Wayne Varvaro would appear
in Sanction as a synchronized text clip named DOWV424.

http://help.lexisnexis.com/litigation/ac/ac_portal/index.html
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TextMap creates a media path in Sanction to the media for any synchronized transcripts that it

sends to Sanction. 

TextMap adds linked exhibits to the Exhibits folder in the Sanction case. 

For more information open the TextMap 7 Answer Center and search for Sanction. Also, you can
see a video explaining how TextMap works with Sanction. 

Related Topics

LexisNexis Answer Center Portal

Overview of Importing

Preferred Media Paths

Support Notes

This article provides support notes that pertain to Sanction 4. 

If you need more information, you can email the Sanction Support team at: 
casemap.support@lexisnexis.com, or call 800.833.3346 (option 3). The Sanction Support team is
available between the hours of 9:00 a.m. to 9:00.

About case backups

When you open your case file, Sanction creates a backup of it so that if your case file is
accidentally deleted or becomes corrupt, you can continue working on the case by using the
backup copy. Note that only the case file itself is backed up in this way; exhibit files, transcripts,
and media elements of the case are not backed up.

The backup case file is saved alongside the case file in the same folder. 

The backup copy is named the same as the case file, but with the hour, minute, and second of the
last backup, formatted as .HHMMSS, appended to the case name. For example, a case named
Hawkins V Anstar.lns3 might have a backup file named Hawkins V Anstar.123400.lns3.

To restore your case from the backup file it is critical that you rename the backup file to the
same name as the original case file. Then you can restart the case using the renamed bakcup
file. If you open the backup file without renaming it first, Sanction will be unable to establish
links to the case items. 

To restore your case from the backup file

1. Close Sanction.

2. If the original case file still exists, then rename it. You don't need to delete it, just renaming it is
sufficient.

For example, if your case name is MyCase.lns3 rename it to MyCase_OLD.lns3.

3. Rename the backup file to the original case file name.

For example, if the backup case name is MyCase14567.lns3 rename it to MyCase.lns3.

The backup case file must be renamed to the original case file name or else Sanction will be
unable to re-establish links to case items.

http://help.lexisnexis.com/litigation/ac/xm/xm7.0/index.html?welcome.htm
http://www.lexisnexis.com/en-us/litigation/products/tutorials.page
http://help.lexisnexis.com/litigation/ac/ac_portal/index.html?welcome.htm
mailto:casemap.support@lexisnexis.com
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4. Open the newly renamed backup file in Sanction.

Media playback errors due to inaccessible media

A media playback error will result if the file associated with a media item is inaccessible by the
player. Media playback errors occur with any the following item types:

Video or audio

Media clips

Playlists

Video in synchronized transcripts

Symptoms

The problem presents differently in the main program window versus in the presentation window. 

Main program window Presentation window

In the media player, you see the following error
message: "Media File not found. Browse to
locate Media File or Refresh to search preferred
media paths." 

In the presentation window, the playback of
media, a media clip, or a playlist stops. There
is no other indication of an issue, except you

can see an error icon  in the presentation
toolbar. The tool tip for the warning reads,
"Unable to load file for selected item."

Cause

Playback problems may result when any of the following conditions are true:

The file was renamed since it was imported into the case. If the file was renamed, you can try

changing it back to the name it had when it was imported. If you do not know the original
name, you can find this out by opening the Media task area. Select the media item. The file
name registered for the media item when it was first imported can be found in the second
column of the media item list.

Your computer is no longer connected to the network or device that holds the media file. If this

is the case, try to re-establish a connection to the network or device. 
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The path to the media file is not listed as a preferred media path for the case. The steps to

resolve this condition are described in the table below. For more information on how to prevent
this issue, see: Preferred Media Paths.

The file was moved since the time it was imported. If the file was moved, you can add a

preferred media path to the new folder location for the media file, or, move the file back to its
original folder.

If the media playback issue is with a synchronized transcript, it can be that the media for the

transcript was never imported. In this case, try to import the transcript media. For more
information, see: Importing Media. Or add the path to the media file as a preferred media path
for the case. This method is described the following table.

The following table provides the steps for establishing a preferred media path to a missing media
item. This can be done whether a presentation is running or not.

From the main program window From the presentation window while a
presentation is running

Resolution 

1. In the media player window, click Browse.

2. Browse to the folder that contains the media
file. 

3. Select the media file and then click Open.

4. In the media player window, click Refresh.

Resolution 

You can resolve media path issues while a
presentation is running without closing the
presentation.

1. With the presentation still running, return
to the main program area.

2. On the FILE tab click Info.

3. Select Media Paths.

FILE > Info > Media Paths

4. In the Case Media Paths dialog box, click 
Add.

5. Select Browse and then browse to the
folder that contains the media file.

6. Click Select Folder.

7. Click OK and then click OK again.

8. Switch back to the presentation. 

9. Reload the media item.

Export of media-related items stops if Expression Encoder is not installed

Microsoft Expression Encoder 4, Service Pack 2 must be installed for the export of media, media
clips, or playlists. If you do not have Expression Encode installed and attempt to export media an
error message will open and the export process will stop.
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Resolution

There are two possible resolutions:

Download and install the Microsoft Expression Encoder 4 with Service Pack 2 (SP2) from

Microsoft.com. (http://www.microsoft.com/en-us/download/details.aspx?id=27870). 

Uninstall Sanction. Then install Sanction again, this time selecting the option to also install

Expression Encoder. Reinstalling Sanction removes any prior activation so it may need to be
reactivated. For more information on activating Sanction, see: Activation. 

Media playback fails when codecs are missing

Symptom

After importing a media file, when you try to open it in the media player, an error message box
opens saying it cannot play the file.

Cause

A codec may be missing that allows your computer to play the media file.

Background

A codec is a small program that allows your computer to play a specific type of media file. Your
computer needs a different codec for each type of media file you want to play. When you attempt
to open a media item in Sanction, playback will fail if the codec required to play that type of file is
not installed.  

More Information

Codec support for the media player in Sanction  is provided by the Microsoft Windows Media Player
12. The range of codecs installed with Windows Media Player 12 is extensive and allows playback
of the most commonly used media file types and subtypes. For more information on working with
codecs with Windows Media Player 12, especially with determining which codecs are installed on
your computer and how to add new ones, see the Microsoft Knowledge Base article, Basics about
videos and video codecs in Windows Media Player on the Microsoft support website.

Sanction log files

Sanction writes log files that store usage data for the 10 most recent sessions. If you need to
contact support, you can provide them with log files, which might help to troubleshoot Sanction.
Sanction saves the log here: 

C:\Users\UserName\AppData\Local\LexisNexis\Sanction\3.6

Where UserName represents the user name you use when you log on to Windows to run

http://www.microsoft.com/en-us/download/details.aspx?id=27870
http://www.microsoft.com/en-us/download/details.aspx?id=27870)
https://support.microsoft.com/kb/2395168
https://support.microsoft.com/kb/2395168
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Sanction.

Related Topics

System Requirements

Installing Sanction

Activation

Moving Cases and Media Files

Preferred Media Paths

Importing Transcripts

Importing Media

Copyright Information

No part of this work may be reproduced or transmitted in any form or by any means, electronic or
mechanical, including photocopying, recording, or by any information storage or retrieval system,
without permission.

While the information contained herein is believed to be accurate, this work is provided "as is,"
without warranty of any kind. The information contained in this work does not constitute, and is not
intended as, legal advice.

LexisNexis and the Knowledge Burst logo are registered trademarks of Reed Elsevier Inc., used under
license. Sanction is a registered trademark of LexisNexis, a division of Reed Elsevier, Inc. 

Apple QuickTime® application program is a registered trademark of Apple Inc. Microsoft® software,
Windows® operating system, Expression® application development tools, and .NET® developer
platform are registered trademarks of Microsoft Corporation. Other products or services may be
trademarks or registered trademarks of their respective companies. 
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in main program window     93

in presentation window     170
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creating during presentations     170

deleting all     89

highlighting     89

layers     89

redactions     89
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- B -
Bates numbering    

multiple exhibits (wizard)     110

blind typing     173

buttons     15, 18, 21, 23, 27, 30, 32

- C -
case    

default folder path     44

practice case     48

CaseMap    
integration     211
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moving     46

openning     45

pinning to recent cases     45

restoring from backup     212

Clip Creator     15, 18, 21, 23, 27, 30, 32, 121

clip lists    
creating     150

importing     150

codec support     212

copyright notice     216

creating    
cases     45

folders     55

media clips     121

playlists (multiclips)     126

preferred media paths     134

presentations     160

screen captures     101

tear outs     103

text clips     106, 152

video stills     108, 137

- D -
default case directory     44

defaults     89

deleting    
folders     55

items     52

presentations     160

display to a projector or monitor     189

drag and drop import    
exhibits     60

media     77, 116

duplicates    
importing     59

receiving from TextMap     211

- E -
editing item properties     53

exhibit pages    
add or replace     88

Exhibit stamps     95
delete all     97

exhibits    
Bates numbering a single exhibit     53

Bates numbering multiple via wizard     110

exporting     193

file formats     59

importing     60

moving     54

page view controls     113

printing     98

renaming a single exhibit     53

renaming multiple via wizard     110

renumbering a single exhibit     53

renumbering multiple via wizard     110

rotate     99

saving as new page     100
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exhibits    
screen captures     101

stamps     95

text clips     106

video stills     108, 137

Exhibits navigation bar     15, 18, 21, 23, 27, 30, 32

exporting    
exhibits     193

media clips     193

playlists     193

extended desktop     189

- F -
FILE tab     15, 18, 21, 23, 27, 30, 32

folders    
deleting     52

user     55

Windows file system     46

- H -
HOME tab     15, 18, 21, 23, 27, 30, 32

hotkeys     203

How-to training videos     15

- I -
IMAGE TOOLS tab     15, 18, 21, 23, 27, 30, 32

images    
rotate     99

importing    
clip lists     150

exhibits     60

how duplicates are handled     59

media     77, 116

overview     59

supported file formats     59

transcripts     83, 141

installation     39

installing    
reinstalling     40

system requirements     41

IPro .LFP files     60

item properties    
main article     53

item types     51

items    

deleting     52

searching     156

- K -
keyboard shortcuts     203

- L -
layers    

exhibit stamps on Layer 1     95

licensing     38

load files for exhibits     60

log files     212

- M -
media    

adding to playlists     126

copying video to the Media folder     137

file formats     59

importing     77, 116

media clips     121

Media file not found     212

moving     54

mute during presentations     184

preferred media paths     134

set volume during presentations     184

updating media paths when moving     46

media clips    
adding to playlists     121, 126

adding to presentations     121

creating     121

deleting     52

exporting     193

from synchronized transcripts     143

Media File Not Found message     134

Media navigation bar     15, 18, 21, 23, 27, 30, 32

media paths     134

menu items     15, 18, 21, 23, 27, 30, 32

Microsoft .NET Framework 4.5    
installed with Sanction 3.5 and higher     39

Microsoft Expression Encoder 4, SP 2    
installed with Sanction 3.5 and higher     39

required for media export     39

side-by-side installation     39

moving    
cases     46
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moving    
exhibits     54

media     54

multiclips -- see playlists     126

multiple displays     189

mute media     184

- N -
navigating     15, 18, 21, 23, 27, 30, 32

navigation bars     15, 18, 21, 23, 27, 30, 32

- O -
Opticon .LOG files     60

- P -
pages    

rotate     99

playlists    
adding a media clip to     121

adding one to a presentation     126

creating     126

deleting     52, 126

editing     126

exporting     193

preferred media paths     134

presentation window     15, 18, 21, 23, 27, 30, 32
searching transcript text     158

presentations    
adding a media clip to     121

adding items     162

adding playlists     126

adjust volume     184

annotation tools     170

blind typing     173

changing item sequence     165

closing     186

creating     160

deleting     160

display selection     189

finding item sources     164

layout     177

media playback     184

monitors     189

multiple item windows     177

mute     184

Next and Previous Item buttons     177

opening     186

paging between items     173

removing items     162

renaming     160

selecting items from a list     173

setting defaults     165

showing items     190

unmute     184

Presentations navigation bar     15, 18, 21, 23, 27, 30,
32
printing    

exhibits     98

- Q -
Quick Clips     121

- R -
recent cases    

pinning     45

redactions     89

reinstalling     40

release notes     202

renaming    
folders     55

items     53

multiple exhibits (wizard)     110

presentations     160

renumbering    
multiple exhibits (wizard)     110

replacing    
exhibit pages     88

reports    
Duration List Report     199

restoring cases     212

- S -
sample case     48

Sanction    
activation     38

integration with TimeMap, TextMap, and CaseMap
    211
navigating     15, 18, 21, 23, 27, 30, 32

practice case     48

reinstalling     40
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Sanction    
support notes     212

system requirements     41

user interface     15, 18, 21, 23, 27, 30, 32

version 3.x     39

version II.9     39

saving    
cases     45

screen captures    
how to create     101

where stored     101

search    
by item date     156

by item properties     156

for case items     156

for transcript text     158

Show Item command     190

Starting Sanction     40

synchronized transcripts    
main article     143

Media File Not Found     134

using clip lists to create clips     150

system requirements     41

- T -
tabs     15, 18, 21, 23, 27, 30, 32

tear out tool    
how to use     103

on annotation toolbar     89

setting the default     103

text clips    
from synchronized transcripts     143

how to create     106

main article     152

where stored     106

TextMap    
integration     211

TimeMap    
integration     211

trademarks     216

transcripts    
creating text clips from     106

file formats     59

importing     83, 141

searching the text of     158

viewer options     154
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